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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications.

This Concepts and Procedures guide provides information and instructions to help 
you work effectively with Oracle Marketing Online.

This preface explains how this guide is organized and introduces other sources of 
information that can help you.

Structure
This guide is written and optimized for online help. This means that it is written in 
short self-contained topics which are linked together with hyperlinks. The topics are 
optimized for online delivery. This means that this guide is best read in the PDF 
format. Printing this document makes it impossible for you to follow the hyperlinks 
between topics.

The topics in this guide are organized in the following topic groups rather than in 
chapters:

� “Understanding Oracle Marketing Online” provides overviews of the 
application and its components, explanations of key concepts, features, and 
functions, as well as the relationship of the application to other Oracle or 
third-party applications.

� “Using Oracle Marketing Online” provides process-oriented, task-based 
procedures for using the application to perform essential business tasks. 

� “Administering Oracle Marketing Online" provides task-based procedures for 
required for ongoing application maintenance.
xi



� “Implementing Oracle Marketing Online” provides general descriptions of the 
setup and configuration tasks required to implement the application 
successfully.

Intended Audience
The Understanding and Using topic groups of this guide are aimed at the following 
users:

� All marketers using the application

� Marketing application administrators

The Administering topic group is aimed at:

� Power users of the application

� Marketing application administrators

The Implementing topic group is to be used by experienced system administrators 
and Oracle implementation consultants who understand Oracle ERP applications 
only. 

Related Documentation and Resources
The following documents are useful for implementing Oracle Marketing Online:

Oracle Applications Concepts (A82932-01)
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind and major issues for applications-wide features 
such as Business Intelligence (BIS), languages, character sets, and self-service 
applications. It also describes Forms-based and HTML-based products. 

Oracle Applications System Administrator’s Guide (A75396-02)
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 

Note: You must be an experienced system administrator and have 
an understanding of Oracle ERP applications before proceeding 
with the procedures in the Implementing topic group.
xii



menus and online help, and manage processing. It also includes information 
relevant for setting up dbc files for Oracle Web Discoverer. 

Oracle Pricing User’s Guide (A77032-01)
Implementers will need this guide to set up pricing features of the Oracle Marketing 
Online.

Oracle System Administrator’s Guide (A75396-01)
The Implementation Appendix of this guide gives valuable information on 
implementing Oracle applications.

Implementing CRM Applications Release 11i (A85301-01)
This guide outlines the steps required for implementing the Oracle Marketing 
Encyclopedia System. 

CRM Foundation Implementation Guide (A86122-01)
This guide outlines the steps required to implement the foundation components of 
the CRM suite of applications.

Oracle Inventory User's Guide (A83505–01)
This guide outlines the implementation steps required to set up Oracle Inventory.

Discoverer 3i Installation & Administration Guide Release 3.3 for the 
Web (A66104-02)
This guide outlines the implementation steps for Oracle Web Discoverer.

BIS11i Implementation Guide (A77481-02)
This guide outlines the steps required to create the End User Layer (EUL) and 
import EUL Export File (EEX) for Oracle Web Discoverer. 
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Understanding Oracle Marketing Online

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the relationship of 
the application to other Oracle or third-party applications.

Overview
Oracle Marketing Online functionality is organized by the following major tabs:

� Campaigns: This is where you organize your campaigns and track related tasks, 
assignments, activities, creative material, and other elements designed to 
promote or sell concepts, products, and services.

� Events: This is where you set up and track trade shows, product launches, 
seminars, and other such activities that are created and executed to support a 
campaign

� Audience: This is where you set up lists, segments, or queues of prospects and 
customers toward which marketing activities are directed.

� Deliverable: This is where you associate creative material that carries or 
presents the message of the campaign to the prospective customer.

� Budget: This is where you allocate budgets to finance a campaign or event.

� Message: This is where you create company messages you can attach to a 
campaign.

� Admin: This is where you and the application administration team create 
venues, marketing mediums, and other setups.
Understanding Oracle Marketing Online 1



About Navigating Through Oracle Marketing Online
About Navigating Through Oracle Marketing Online
You navigate through the application by clicking on the tabs, subtabs, buttons, and 
check-list attributes. 

This topic introduces some of the Oracle Marketing Online user-interface elements 
and explains how they are used. The topics covered are:

Tabs and Subtabs
There are two types of window arrangements in Oracle Marketing Online: 

� Windows with three levels of tabs

� Windows with two levels of tabs and a check list

Windows with Three Levels of Tabs
Some windows use up to three tab levels to control what is displayed in the 
window.

Interface Element (Click 
for information) Brief Explanation

Tabs and Subtabs Three levels of tabs provide navigation 
through the application.

Check Lists Contain categories of information users 
must enter for an object such as a 
campaign or event. Each item in the 
check list is called an attribute. It 
becomes checked off when you make 
an entry.

Folders Display the hierarchical structure of 
information. They show, for example, 
which metrics summarize others and 
how metrics relate to each other.

Bins Provide shortcuts to recently-visited 
objects from the Home tab.
2 Oracle Marketing Online Concepts and Procedures



About Navigating Through Oracle Marketing Online
Here are the three types.

Windows with Two Levels of Tabs and a Check List
Some windows can have up to two levels of tabs and a check list.

Here are the three types.

Number Interface Object Description

1 Tabs. The active tab appears in a different color than 
the other tabs. 

2 Level 1 subtab. The name of the active subtab 
appears highlighted.

3 Level 2 subtab. These subtabs are hyperlinks. The 
active subtab appears highlighted. 
Understanding Oracle Marketing Online 3



About Navigating Through Oracle Marketing Online
References
How This Help System Represents Navigation Paths

Check Lists
A check list organizes the information your team enters and tracks in a campaign, 
an event, a deliverable, an offer or another object. Each item on the check list, called 
an attribute, represents a type of information you wish to track or action you wish 
to take. For example, a product launch campaign requires you to enter information 
about the products the campaign is targeting in the Products check-list attribute. To 
schedule an activity such as an email blitz, you go to the Schedule check-list 
attribute.

A check mark next to a check-list attribute indicates someone in your team or the 
application itself has entered information there. The check mark does not indicate 
that the information is accurate or complete.

Using the Admin tab, application administrators create Custom Setups which 
determine what items appear in the check list for campaigns and events and the 

Number Interface Object Description

1 Tabs. The active tab appears in a different color 
than the other tabs. 

2 Level 1 subtab. The name of the active subtab 
appears highlighted. 

3 Check list. The selected check-list attribute is 
highlighted. A check mark appears next to an item 
after you make an entry in any of the fields of that 
item. A check mark does not mean all the required 
fields have been filled out.
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About Navigating Through Oracle Marketing Online
order of the attributes in the list. All other check lists have a fixed list of attributes 
that cannot be modified.

Folders
Oracle Marketing Online uses the folder metaphor to display the parent-child 
relationship between objects.

Parent objects, such as summary metrics and costs, are represented by folders with 
a plus sign:

Clicking on the folder icon displays the child objects indented below. For example, 
clicking on the Total Cost metric displays the metrics it summarizes:

Bins
Bins are the regions of the Home tab that display information on budgets, 
campaigns, deliverables, and rollup events. Here is the Budget bin, as an example:

Note: The General check-list attribute is not an attribute. It is the 
Detailed subtab where you enter general information about the 
campaign, event or another object. 
Understanding Oracle Marketing Online 5



How This Help System Represents Navigation Paths
How This Help System Represents Navigation Paths
Here is the convention used by this documentation to describe user navigation:

� Tab > subtab1 > subtab2

� Tab > subtab1 > check-list attribute

� Tab > Create: Select the tab and click the Create button. For instance, to create a 
new campaign, the user selects the Campaign tab and clicks Create. 

Understanding Campaigns
You construct campaigns using two building blocks:

� Rollup campaigns

� Execution campaigns and marketing mediums

Rollup Campaigns
You use rollup campaigns to track the general information about a campaign and to 
build a hierarchy of rollup campaigns in your organization. The hierarchy, which 
you build by linking one rollup campaign to another, determines how budgets are 
approved and allocated and how costs and metrics are reported in your 
organization.

You also use rollup campaigns to group similar execution campaigns. For example, 
if your company is promoting a new product through an email campaign, and a 
combination of print and television advertising, then you may create a separate 
rollup campaign for each type of marketing mediums: one for email, one for print, 
and one for television. Each rollup campaign can contain as many execution 
campaign as you like, each with details on the particular advertisement or email 
you are sending out.

Execution Campaigns and Marketing Mediums
An execution campaign is where you store information on how a campaign is 
executed through a marketing medium. A marketing medium is the marketing 
channel for your marketing activity. It is the specific magazine or television station 
where you advertise or the telemarketing center executing your campaign. 

An execution campaign can hold information on only one marketing medium. This 
means that you must create a separate execution campaign for every marketing 
medium you are using for the campaign. For example, if you are promoting a 
6 Oracle Marketing Online Concepts and Procedures



About Campaign Hierarchies
product through magazine advertisements, then you must create a separate 
execution campaign for each magazine where you are running the advertisement. 

You can associate an execution campaign with a parent rollup campaign but not 
with another execution campaign. You cannot build a hierarchy of execution 
campaigns. Execution campaigns are always at the bottom of any rollup campaign 
hierarchy you create.

See Also
About Campaign Hierarchies

About Naming Campaigns

About Campaign Hierarchies
Because the campaign hierarchy you create determines how budgets are dispersed 
and information is gathered about performance of campaigns, it must reflect your 
business structure. 

Consider a multinational company with a global campaign for two products: 
Widget and eWidget. The company has three regional offices for the Americas, Asia 
Pacific, and Europe Africa as well as branches in major countries. The company 
changes campaigns quarterly.

The resulting campaign hierarchy may look something like the one in the following 
diagram. You should note that all of the campaigns shown in this diagram are 
rollup campaigns. Each country tracks their own marketing activities by setting up 
execution campaigns.
Understanding Oracle Marketing Online 7



About Naming Campaigns
About Naming Campaigns
Your organization must use a naming convention that makes it easy to distinguish 
between campaigns. This is because all campaigns appear alphabetically on the 
same list regardless of their position in the campaign hierarchy.

For example, you may want to adopt a naming convention similar to the following:

<year><quarter><product><region or country>

"01Q1 Widget Americas" then becomes the campaign for the first quarter of 2001 for 
the product Widget for the Americas region.

You can view where a particular campaign is in the campaign hierarchy by 
examining its Parent field.
8 Oracle Marketing Online Concepts and Procedures



Understanding Budgets
How Campaigns Are Approved
Campaigns are approved according to predefined business rules entered in Oracle 
Workflow. Oracle Marketing Online provides a predefined Workflow that 
automatically sends campaigns for approval when you change a campaign status to 
the appropriate level. There are two types of approvals:

� Campaign theme approval

� Campaign budget approval

The application administrators must enable the two approval work flows in the 
Admin tab when they are setting up the campaign types. 

Campaign Theme Approval
When you change the status of a campaign from New to Planned, Oracle Marketing 
Online sends a request for approval either to the owner of the campaign if you are 
not the owner, or, if you are the owner, to the person who is listed as your 
supervisor in Oracle Human Resources. The application automatically changes the 
campaign status to Submitted for Approval. You receive a notification in your 
Personal Home Page when the campaign owner or your supervisor approves or 
rejects the campaign. If the campaign is approved, the status changes to Planned. If 
the campaign is rejected, then the status becomes Denied Theme Approval.

Campaign Budget Approval
When you change the status of a campaign from Planned to Active, Oracle 
Marketing Online sends to the budget owner a request for approval of the budget 
amount you have entered in the Budget check-list attribute. If the budget for your 
campaign comes from a rollup campaign rather than a budget, then the person 
approving your request is the owner of that rollup campaign. The campaign status 
changes to Submitted for Budget Approval. You receive a notification in your 
Personal Home Page if the budget owner approves or rejects the campaign. If the 
budget is approved, then the status of the campaign becomes Available. If the 
budget is denied, then the status becomes Denied Budget Approval. 

Understanding Budgets
Budgets are the source of funding for marketing campaigns, events, and 
deliverables. Only a few marketing managers within your organization have the 
permission to create budgets. Marketers can only request funds from an existing 
budget.
Understanding Oracle Marketing Online 9



Understanding Tasks
Marketing managers can create a budget hierarchy by associating budgets with a 
parent budget. When you create a budget that is a child to a budget you do not 
own, then the owner of the parent budget is automatically notified of your request 
for funding. A budget can become active, and used for funding campaigns only 
after your request is approved. Funds are automatically deducted from the parent 
budget when the child budget is approved.

Ideally, the budget hierarchy should match the campaign hierarchy that uses it. That 
way a marketer creating a campaign or an event knows from which budget to 
request funds. 

When the budget owner approves a budget request for a campaign or an event, that 
amount is set aside from the budget. It cannot be released unless the campaign or 
event status is set to cancelled.

Costs incurred by campaigns, events and other marketing activities are not tied to 
budgets so they are not deducted. 

Understanding Tasks
A task is a job that is planned, created and then accomplished by the assigned 
individual or group in furtherance of a campaign or event.

Examples of task types that can be implemented in Oracle Marketing Online 
include:

� Lunch

� Presentation

� Execution

� Milestone

Task status is monitored through email alerts and Workflow notifications that are 
managed by Oracle Workflow to keep approvers current on campaign progress.

Understanding Events
This topic gives an overview of event functionality and explains the differences 
between the two building blocks you use to set up and track events: rollup and 
execution events. It covers:

� Event overview

� Event building blocks
10 Oracle Marketing Online Concepts and Procedures



Understanding Events
Event Overview
An event can be a seminar, a class, a product demonstration, or any other activity 
related to a campaign. You can create an event as a stand-alone activity or as part of 
a campaign. Using events a marketer can:

� Track and distribute event information. This includes information about events 
speakers, directions, deliverables, and budgets.

� Set up event prices and payment methods

� Manage open and restricted registration under the control of rules and lists

� Integrate with call centers and Web sites to distribute information and to 
facilitate registration

You can use Events to enroll attendees in event offerings. Event types include 
seminars, product demonstrations and classes.

Where applicable, event payment can be processed using a credit card or purchase 
order. You can send enrollees event deliverables that includes descriptions, 
directions, maps, and cover letters.

Events tracks the number of spaces available for the event. If space is unavailable, 
the contact is placed on a waiting list. The application can (depending on 
implementation), automatically enroll a contact on a wait list if space becomes 
available, or notify agents through work queues to contact prospective enrollees for 
confirmation.

Event Building Blocks
Just as you do for building campaigns, you use two building blocks to set up and 
track events:

� Rollup events: This is a template where you enter general information about an 
event such as the description, costs, deliverables, venue, directions to the event, 
and the campaign used to promote the event. A company offering a sales 
seminar worldwide, for example, enters the information common to all the 
individual country sales seminars here. This information can then be 
customized for each separate country, location and time using execution events.

� Execution events: Allow you to customize the general information you entered 
in rollup events to create specific events and to track participation and 
enrollment in each. For example, a country manager of the company offering a 
sales seminar worldwide creates an execution event for the local seminar with 
its own times, speakers, and costs associated with each specific event.
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Understanding Deliverables
Understanding Deliverables
A deliverable is any type of creative, advertising, or promotional material used to 
support the campaign. A deliverable can be:

� A physical item, such as a data sheet or a logo-bearing pen

� An electronic file, such as a banner ad, video clip, or logo design

Different Ways of Finding Information
Oracle Marketing Online provides you with three ways to find the information:

� Select a view of campaigns, events, deliverables, and other objects

� Use the Quick Find function to search information

� Perform a detailed search using Advanced Search

Different Views of Objects in the Database
When you click on a tab, the application automatically searches the database and 
lists all objects you can edit. For example, clicking on the Campaign tab displays the 
My Campaigns view listing all of the campaigns that you have created or for which 
you are listed as a team member. 

You can change the view and query the database again by making a different 
selection from the View drop-down list. In the Campaign tab, for example, selecting 
All Campaigns displays all the campaigns you have permission to view. If you view 
the details of a campaign you have permission to view but not to edit, then the 
campaign appears as a report only.

To help you find objects, you can sort the list by clicking on a column name. 
Columns you can sort by appear as hyperlinks.
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Available Campaign Views
If the list of objects is too long for you to find what you are looking for, you can use 
the quick find or detailed method to search the Oracle Marketing Online database.

You can use Advanced Search to search for messages, campaigns, deliverables, 
events, and lists. 

Quick Find
Use Quick Find if you know at least part of the name of the object you are looking 
for. 

You can use the% sign as a wild card. For example, to search for a campaign, you 
select Campaigns and enter a partial campaign name. If you enter Q1%, for 
instance, the application returns a list of all campaigns with names that begin with 
Q1.

Advanced Search
Advanced Search allows you to enter the widest variety of criteria for your 
searches. This includes by market segment, by product and by deliverable.

See Also
Available Campaign Views

Available Campaign Views
You can display the following views of campaigns by making a selection from the 
View drop-down list:

� My campaigns: Campaigns you own or have update privileges for. 

� All campaigns: All campaigns you can view. 

Note: You cannot search within Oracle Marketing Online for 
notes, attachments, tasks, and other objects other than those listed 
above, you can find these by viewing the objects to which they are 
associated. Tasks can also be viewed in your Home page.
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Who Can See Which Campaigns
� My country’s campaigns: Lists all campaigns viewable to you in your country. 
You must set up your home country in the preferences page. 

� My division’s campaigns: Lists all campaigns viewable to you in the country 
that belong to your division. A division is one level above your country in the 
geographic hierarchy. For example, the Americas division may consist of USA 
and Canada. If you designate the USA as your home country, then this view 
displays all campaigns in the USA and Canada.

� My team’s campaigns: Lists all campaigns that include you as a team member.

� Campaign Hierarchy: Displays the campaign hierarchy for your organization 
as a tree.

Who Can See Which Campaigns
Oracle Marketing Online restricts access to campaigns according to the following 
rules:

� You can only view a confidential campaign if you are its owner or a team 
member. 

� If you have edit privileges to a campaign, then clicking the campaign name 
hyperlink takes you to the details subtab where you can edit campaign details.

� If you have view privileges only, then clicking the name hyperlink displays 
campaign information in a report you cannot edit.

About Offers
You can use Oracle Marketing Online to set up five different kinds of offers:

� Accrual: Sets up points a customer can accrue such as frequent flyer mileage. 
This type of offer is used only by marketers in N-tier marketing organizations. 

� Lump Sum: This type of discount is used for N-tier marketing only. It provides 
the customer a lump sum amount as cash or accrual. This is usually payment 
for the customer’s promotional activities on your behalf. For example, a 
soft-drink company may use a lump sum offer to pay a supermarket for 
promotional activities during the Olympics.

� Off Invoice: This is the currency amount or percentage discount that shows up 
on your invoice. You can set up a simple discount, giving customers a 10 per 
cent discount if they purchase more than $100, for instance. Or you can set up a 
tiered discount, giving customers a greater discount the more they buy. 
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How to Trigger an Email Blitz on the Response Rate of Another
� Order Value: This discount is contingent on the total value of the order. For 
example, you can specify that a customer spending $1000 or more receives a 15 
per cent discount, while a customer spending more than $10,000 receives a 
discount of 20 per cent. 

� Promotional Goods: This type of offer bundles promotional goods along with 
customer purchases. For example, a customer purchasing an ink-jet printer 
receives a cartridge free of charge.

About Executing Marketing Activities Through Schedules
The Schedules check-list attribute is where you enter information on campaign 
activities such as a mass mailing or a telemarketing campaign. The information you 
enter is passed on to the appropriate CRM application where these activities are 
carried out. 

For example, you can specify an offer to automatically display on the company web 
site via Oracle iStore or have your telemarketing organization execute a campaign 
using a script you have created.   

You can schedule multiple such activities for each campaign. 

There are two ways you can create a schedule:

� Manually

� Using a trigger

When you create a schedule manually using the procedure outlined in Scheduling 
Activities for Campaigns and Events, the information about the activity becomes 
available to others in your organization on the dates you specify. A schedule created 
manually has the Trigger check box unselected.

You can also create a schedule automatically by creating a trigger following the 
procedure outlined in Triggering Campaign Actions Automatically. The application 
creates the schedule and executes the action when the condition is satisfied. A 
schedule created by a trigger has the Trigger check box selected. 

How to Trigger an Email Blitz on the Response Rate of Another
You can trigger one email blitz based on the results of another. Suppose you are 
marketing a product in the United States through an email blitz and you wish to 
automatically trigger an email blitz in France if the level of responses reaches 5 
percent.
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How to Trigger an Email Blitz on the Response Rate of Another
Here is how you would set up this scenario using the Trigger function in Oracle 
Marketing Online.

Sample Steps
1. Create a metric called Response Rate that measures the number of responses 

you receive to an email blitz. This requires the help of a programmer or 
consultant.

2. Create a metric called "Trigger Response Rate" according to the procedure 
outlined in Creating metrics. In the Calculation region, select the Enter Value 
Manually. You are creating this metric only for the purpose of storing the value 
you wish to use to trigger the campaign.

3. Create the two email blitzes: 

a. Create the email cover letter mailmerge.

b. Create and a list of type Template that queries the database to extract email 
recipients as described in Creating a List.

c. Create an execution campaign of campaign type Direct Marketing - Email 
according to the procedure found in Creating an Execution Campaign.

d. Associate the two metrics you have created to both campaigns using the 
Metrics check-list attribute following the procedure outlined in 
Determining Which Metrics You Wish to Use.

4. For the French execution campaign:

a. Navigate to the Metrics attribute.

b. In the Actual Value column of the Trigger Response Rate enter the number 
5.

c. Click Update.

5. In the French execution campaign, create a Trigger of type meric to metric. See 
the procedure outlined in Triggering Campaign Actions Automatically.

6. Enter the details for the metric to metric trigger following the procedure in 
Entering Metric to Metric Trigger Details:

a. For the Monitor Setup, be sure to enter the frequency you wish to check for 
the condition. 

b. For Metric Name, select Trigger Response Rate

c. Select "Actual Value" as the metric type.
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About List Types and Templates
d. For the operator, select the smaller-than-or-equal-to symbol.

e. For object type, select Campaign.

f. For Object Name, use the list of values to enter the name of the US 
campaign.

g. For Metric Name (on the right side of the equation), select Response Rate.

h. For Metric Type, select Actual Value.

i. Select the Send Notification to Owner check box. This sends the owner a 
message when the blitz is executed.

j. Select the Generate List check box.

k. Using the drop-down list select the list of type Template you have created 
for the blitz.

l. Select the Schedule for Immediate Execution check box. 

m. Click Update. 

The Trigger checks for the condition at the times you specified in Monitor Setup. If 
the condition is met, the trigger creates a schedule and executes the French blitz. 
The emails are sent as soon as the concurrent program creates the mail merge for 
your list. 

About List Types and Templates
You can create list of two different types using the same list creation procedure 
outlined in Creating a List:

� Target: This queries the database and generates a fixed list of customers or 
prospects. You can use this list to schedule campaign activities by associating 
the list with a campaign schedule or use it as an invite list by associating it with 
an execution event.

� Templates: Templates store both the current list of customers as well as the 
query criteria used to generate that list. Every time you copy or use the 
template, the query is run automatically and the list is refreshed from the 
database. This assures that you are using the most up-to-date list of customers 
or prospects. Create a template if you are executing the list via a campaign 
trigger or you wish to create a list for future reuse. 
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About Creating Lists
About Creating Lists
You can create a list by querying your database, from two or more existing lists, or a 
combination of the two methods. 

This topic explains the basic process for creating a list by:

� Querying your database

� Combining two different lists

� Creating lists from multiple sources

Creating a List by Querying Your Database
The simplest form of a list is the one you create by querying your database. 
Creating such a list is a two-step process: 

1. Using Oracle Web Discoverer, a companion application linked to Oracle 
Marketing Online, you create a query, called a workbook.

2. During the list creation process in Oracle Marketing Online. you select the 
workbook you wish to use. 

When the query contained in the workbook is executed either through a campaign 
schedule or a trigger, it returns the customers or prospects that fit the query criteria.

Creating a List from Two Existing Lists
You can create a list by combining two existing lists. There are three different ways 
of combining the lists: 

� Including all the customers or prospects in both lists

� Using the intersection of both lists

� Excluding the individuals in one list from those in the other list

This method of creating new lists is preferable to creating a fresh list using a 
workbook whenever you want to target prospects or customers in an existing list. 

Suppose you have recently targeted a marketing campaign to a list of males over 30 
years of age. You now wish to follow up with an upsell offer to those of them who 
earn over $70,000 per year. 

If you create a new list that queries the database for males over 30 in this income 
bracket, then the resulting list will contain any new individuals matching this 
profile who have been added since you ran the campaign. You do not want to target 
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About Creating Lists
these new prospects with the upsell offer because they will not be familiar with 
your original offer. 

Creating a new list based on an intersect of the list you used for your campaign and 
a list of individuals over $70,000 per year limits the targets to the individuals 
targeted by your original offer. 

About Creating Lists from Multiple Sources
You can create a list from multiple existing lists and workbooks.

The application combines any number of lists and workbooks based on the action 
you select for each source in the order you specify.

The available actions are the same we used to extract a new list from two existing 
lists in our previous example:

� Include

� Intersect

� Exclude

The order you specify tells the application the order in which to combine the lists.

If you are combining two lists, then the list order does not matter. An intersect 
between list A and list B yields the same results as an intersect between list B and 
list A. 

But the order matters when you have more than two sources for your list. Suppose 
you have three different lists: 1, 2, and 3 that the application processes in the 
following order:

The shaded area in the diagram below represents the resulting list:

Order List Action

1 List 1 Include

2 List 2 Intersect

3 List 3 Include
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About Creating Lists
Now suppose you change the order of the lists as follows while keeping the actions 
the same:

The following diagram shows the resulting list.

Order List Action

1 List 1 Include

2 List 3 Include

3 List 2 Intersect
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About Workbooks, Worksheets, and Oracle Web Discoverer
About Workbooks, Worksheets, and Oracle Web Discoverer
Oracle Marketing Online includes Oracle Web Discoverer, a separate application 
which non-technical users can use to create database queries for list creation.

This topic explains a few key terms:

� Folders, field icons, and the End User Layer (EUL)

� Worksheets

� Workbooks

� Conditions

Folders, Field Icons, and the End User Layer (EUL)
Oracle Web Discoverer’s graphical user interface represents query terms as folders 
and field icons. Users move these from left to right to create a query:
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About Workbooks, Worksheets, and Oracle Web Discoverer
The folders represent different views of the database. The Contacts OK to email 
folder, for example, lists all of the customers in the database who have indicated 
that they can be emailed. 

The fields represent customer attributes, including name, telephone number, age, 
and so on. 

Oracle Marketing Online application development team has created folders and 
fields in Oracle Web Discoverer that are specific to marketing. Together this is called 
the End-User Layer.

Worksheets
The query you create by moving the folders and fields to the right side of the 
window is called a worksheet. It is these individual worksheets that you use in the 
list creation process.
22 Oracle Marketing Online Concepts and Procedures



Available Mailmerge Fields
Workbooks
When you save the query, Discoverer automatically creates a workbook for the 
worksheet. In this respect, Discoverer is analogous to Microsoft Excel where each 
sheet is stored in a book. 

If you wish, you can store multiple worksheets in a workbook. But for the purposes 
of Oracle Marketing Online you are better off having just one worksheet per 
workbook.

This is because you select individual worksheets and not workbooks for list 
creation.

Oracle Marketing Online does not distinguish between worksheets and workbooks. 
Both are called by the generic term workbook and both appear in the list of values 
when you add workbooks during list creation. 

Conditions
You can apply a condition to the worksheet to further constrain the query. For 
example, if you wish to create a worksheet that retrieves only the contact and email 
records for one organization, the Global Enterprise organization, then the condition 
you will use is Organization Name = “Global Enterprise”.

See Also
 Creating Workbooks in Discoverer

Available Mailmerge Fields
The following fields are available for use in cover letters depending on which of the 
two seeded queries you select:

Marketing Simple Query:
� title

� first_name

� last_name

� pin_code

Marketing Detailed Query:
� title 
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Available Mailmerge Fields
� first_name

� last_name

� pin_code

� inbound_dscript_name

� inbound_url

� inbound_email_id

� inbound_phone_no

� source_code

� offer_code

References
� For information on how to create a mailmerge letter using these fields, see 

Creating a Mailmerge Letter
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Using the Home Tab Shortcuts to Recent Work
Using Oracle Marketing Online

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

Using the Home Tab
Use the Home tab to read company news, manage your marketing tasks, and gain 
quick access to your most current campaigns and events.

You can obtain help on how to:

� Use the home tab shortcuts to recent work

� View tasks assigned to you

� Change the priority, status, and due date of your tasks

� Reassign a task to someone else

Using the Home Tab Shortcuts to Recent Work
The Home tab provides shortcuts to the campaigns, deliverables, and events you 
have worked on most recently. The shortcuts are generated automatically when you 
create or edit an object such as an event or campaign. Use this procedure to learn 
how to use the shortcuts.

Prerequisites
None

Steps
1. Navigate to the Home > Home subtab. Usually this is the subtab you see when 

you select the Home tab.

2. Click on a hyperlink to display the item. 

Guidelines
You can specify how many most recent items you wish to see on the Home tab 
using the Personal preferences window.
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Viewing Tasks Assigned to You
Viewing Tasks Assigned to You
Use this procedure to view tasks assigned to you. 

Prerequisites
None

Steps
1. Navigate to the Home > Task subtab.

2. From the View drop-down list select My Tasks.

The list displays tasks assigned to you.

3. If you wish to limit the view further by priority or status, then use the Filter by 
drop-down lists.

4. If you wish to sort the tasks alphabetically by any one of the columns, click on 
the heading for that column. If you wish to organize the tasks by status, for 
example, then click on the Status column heading.

See Also
Changing the Priority, Status, and Due Date of Your Task 

Changing the Priority, Status, and Due Date of Your Tasks
You can change the priority, status, and due date of your task assigned to you and 
to others in your team.

Prerequisites
None

Steps
1. Navigate to the Home > Task subtab.

2. Make sure the My Tasks is the selected view.

3. If you wish to limit the view further by priority or status, then use the Filter by 
drop-down lists.

4. If you wish to sort the tasks alphabetically by any one of the columns, then click 
on the heading for that column. If you wish to organize the tasks by status, for 
example, then click on the Status column heading.
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Setting Personal Preferences
5. Modify the Priority, Type, Status, or Due Date.

6. Click Update.

Reassigning a Task to Another Person
Use this procedure to reassign a task to another team member.

Prerequisites
None

Steps
1. Navigate to the Home > Task subtab.

2. Click Reassign Assignee.

The Tasks subtab appears.

3. Select the task(s) you wish to reassign to another individual by selecting the 
Select check box next to each.

4. In Reassign Task to field, click Go next and use the list of values to enter the 
individual’s name.

5. Click Update.

Setting Personal Preferences
Use this procedure to change your personal preferences. This includes the number 
of items that appear in the lists of objects on each tab.

Prerequisites
None

Steps
1. Navigate to the General Preferences subtab by clicking on Profile at the top 

right of the window as indicated by the red arrow:
Using Oracle Marketing Online 27



Using the Campaign Tab
2. If you wish to select a different format for entering dates, then make a selection 
from the Date Format drop-down list. 

3. If you wish to change the amount of lines the application displays in tables such 
as the lists of objects at each tab, then, in the Table Display region, use the Rows 
Per Page drop-down list to select a different number.

4. If you wish to change the number of blank lines you can use for entry in a table, 
then, in the Table Display region, enter that number in the Blank Rows Per 
Table field.

5. Click Update.

6. Select the Marketing hyperlink on the top left side of the window.

The Marketing Preferences subtab appears.

7. If you wish to change the number of shortcut items that appear in each bin on 
the Home tab. Bins are the areas on your home tab that provide shortcuts to 
your most recently created campaigns, events, and other objects.

8. If you wish to view stock quotes on your home tab, then, in the User Stock 
Symbols text box, enter the stock ticker symbols for the companies you wish to 
display. Separate the symbols with a comma.

9. In the News Items per Company field, enter the number of news items to 
display for the companies you have entered in the previous step.

10. If desired, use the drop-down lists to define your country, time zone, and your 
default marketing team.

11. Click Update.

Using the Campaign Tab
Use the Campaign tab to manage your marketing campaigns.

You can obtain help on how to:

� View and edit a campaign
28 Oracle Marketing Online Concepts and Procedures



Creating a Campaign
� Create a campaign

�  Copy an existing campaign

For more information see:

� About campaign hierarchies

� About naming campaigns

Viewing and Editing a Campaign
Use this procedure to view and edit an existing rollup or execution campaign.

Prerequisites
None

Steps
1. Navigate to the Campaign tab.

2. If you do not see the campaign you wish to view or edit among those displayed 
in the list, then search for it by changing the View, or using QuickFind and 
Advanced Search.

3. Click on the hyperlink of the campaign you wish to view or edit.

The Campaign Details subtab displays. You are now ready to edit the campaign 
information.

Creating a Campaign
Use this procedure to create a campaign.

Prerequisites
Marketing mediums and campaign types must be set up first.

Steps
1. If you wish to create a campaign that is similar to one of campaigns you have 

already created, then copy an existing campaign and modify it instead of 
creating a new one. 

2. If you want to create a new campaign, then navigate to the Campaign tab. 
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Creating a Rollup Campaign
3. Click Create. 

4. If you wish to create an element of a campaign hierarchy for reporting and 
tracking, then select the Rollup Campaign radio button and follow the steps in 
Creating a Rollup Campaign.

5. If you wish to execute an email blitz, a telemarketing campaign, a marketing 
campaign over the web or another marketing activity, then select the Execution 
Campaign radio button and follow the steps in Creating an Execution 
Campaign.

References
Understanding Campaigns

Creating a Rollup Campaign
Use this procedure to create a rollup campaign. A rollup campaign is used to group 
marketing activities tracked by execution campaigns and to build a campaign 
hierarchy for cost tracking, approvals, and reporting.

Prerequisites
Understanding of your organization’s campaign setup

Steps
1. Navigate to the Campaign tab.

2. Click Create. 

The Create Campaign subtab appears.

3. Select the Rollup Campaign radio button.

The window refreshes.

4. Use the Setup Type drop-down list to select the custom setup for the campaign. 
Custom setups determine what check-list attributes are required for the 
campaign you create. The items that appear on this list are created by the 
application administrator in the Admin tab.

The window refreshes displaying different fields according to the selection you 
made.

5. Enter a name for the campaign. Make sure you use the naming convention set 
up by your organization.
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Creating an Execution Campaign
6. If you are creating the top node of a campaign hierarchy, then leave the Parent 
field blank. Otherwise, use the Parent list of values (LOV) to associate this 
campaign with a campaign that is above it in the campaign hierarchy. Be sure to 
note the available dates of the parent campaign. The available dates for the 
campaign you are creating must fall within the dates of the parent.

7. If you wish to limit access to campaign information to the campaign owner and 
team members, then select the Confidential check box.

8. Enter the start and end dates you wish this campaign to be available for use. 
The dates must fall within the available dates for the parent campaign, if any.

9. Enter a comment and any other optional information.

10. Leave the Source Code field blank. A unique source code is generated 
automatically by the application.

11. Click Create.

The Campaign Details subtab appears.

You are now ready to enter more details about the campaign.

Creating an Execution Campaign
Use this procedure to create an execution campaign. Execution campaigns are 
where you execute campaign activities such as email blitzes and telemarketing 
campaigns and track information about these activities. 

Prerequisites
None

Steps
1. Navigate to the Campaign tab

2. Click Create. 

The Create Campaign subtab appears.

3. Make sure the Execution Campaign radio button is selected.

4. Using the Setup Type drop-down list, select a custom setup. Custom setups are 
templates for different types of campaigns created by your application 
administrator in the Admin tab.
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Creating an Execution Campaign
The window refreshes. Notice that the window displays the activity type and 
activity for the custom setup you chose. 

5. Enter a name for the execution campaign. Make sure you use the naming 
convention set up by your organization.

6. Unless you are creating a stand-alone execution campaign, you must use the 
Parent list of values (LOV) to associate this campaign with a the rollup 
campaign that is above it in the campaign hierarchy. Be sure to note the 
available dates of the parent rollup campaign. The available dates for the 
execution campaign you are creating must fall within these dates. If you are 
creating a stand-alone execution campaign, then you can leave this field blank.

7. If you wish to limit access to campaign information to the campaign owner and 
team members, then select the Confidential check box.

8. Enter the start and end dates you wish this campaign to be available for use. 
The dates must fall within the available dates for the parent campaign.

9. Enter the marketing medium for this execution campaign. This is the channel 
through which the campaign is delivered. For television advertisements, for 
example, this is the television station running your ad. For a telemarketing 
campaign, this is the call center making the calls. For an email campaign, this 
may be the server handling the emails.

10. Optionally, enter the budget for this campaign by using the drop-down list to 
select the currency and entering the amount. This amount is for information 
only. You must enter the actual amount you are requesting in the Budget 
check-list attribute. 

11. Enter a comment and any other optional information.

12. Leave the Source Code field blank. A unique source code is generated 
automatically by the application.

13. Click Create.

The window refreshes and the Campaign Details subtab appears.

You are now ready to enter more details about the campaign.

Note: If you are creating an email blitz, then you must use the 
custom setup Direct Marketing - Email.
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Entering Campaign Details
Entering Campaign Details
Use this procedure to enter details for a rollup or an execution campaign you have 
created.

Prerequisites
You must create the campaign first.

Steps
1. Navigate to the Campaign Details subtab of the campaign you wish to edit.

2. All the required fields in this subtab were filled out when the campaign was 
created. You can modify them now.

3. If you are requesting funds from budgets for this campaign, then: 

a. From the Budget Amount drop-down list, select the currency. 

b. Enter an optional amount. This amount is for information only. Requesting 
funds is done entirely in the Budgets check-list attribute. 

4. Fill out any other optional fields.

5. Click Update.

You are now ready to enter information into the check list attributes associated 
with your campaign. 

These attributes appear on the left side of the Campaign Details window. What 
attributes are listed depends on the type of campaign you are creating.

Note: You must select a currency for you to be able to enter 
budget information in the Budget check-list attribute.

Note: Do not modify the source code. It is generated by the 
system.

Note: A check mark next to an attribute means that an entry has 
been made. It does not mean that all the information has been 
entered.
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Entering Campaign Details
Guidelines:
The table below lists all check-list attributes and whether these are used for rollup 
campaigns, execution campaigns, or both. Rollup campaigns store only basic 
information about campaigns, so the number of available attributes is limited.

Only a subset of these attributes may be listed in the check list for your campaigns. 
This is because different types of campaigns need to track different types of 
information. 

Attribute
Used in rollup 
campaigns

Used in 
execution 
campaigns

Attachments Yes Yes

Budgets Yes Yes

Costs Yes Yes

Deliverable Yes Yes

Geography No Yes

Market No Yes

Message Yes Yes

Metrics Yes Yes

Notes Yes Yes

Offer No Yes

Partner No Yes

Products No Yes

Response No Yes

Schedule No Yes

Tasks Yes Yes

Team Yes Yes

Trigger No Yes
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Associating Deliverables to a Campaign or Event
Requesting Funds for Your Marketing Activities
Use this procedure to request funds from a budget or campaign for your marketing 
activities using the Budgets check-list attribute. In the current release you can only 
request funds from a single budget or campaign.

Prerequisites
� You must select the currency type for your budgets in the Campaign Details 

subtab

� The budget you are requesting funds from must be approved and have the 
status of active.

Steps
1. Use the Type drop-down list to select the type of source for your funds. Most of 

the time the source is a budget, but you can also request funds from a parent 
rollup campaign.

2. Use the Name list of values (LOV) to select the funding source.

3. In Request Amount, enter the amount you are requesting.

4. Click Update.

When you change the status of a campaign from Planned to Active, Oracle 
Marketing Online sends a request for approval of the request to the budget 
owner. If the budget for your campaign comes from a rollup campaign rather 
than a budget, then the person approving your request is the owner of that 
rollup campaign. While the funds are pending, the campaign status remains 
Submitted for Budget Approval. 

You receive a notification in your Personal Home Page when the budget owner 
approves or rejects the campaign. If the budget is approved, then the status of 
the campaign becomes Available. If the budget is denied, then the status 
becomes Denied Budget Approval.

Associating Deliverables to a Campaign or Event
Use this procedure to associate deliverables to campaigns and events using the 
Deliverable check-list attribute. A deliverable can be a physical item, such as a 
brochure, or an electronic file. 
Using Oracle Marketing Online 35



Tracking Costs Using the Costs Check-List Attribute
Prerequisites
You must create a deliverable first before you can associate it with a campaign or 
event. If the deliverable is a physical object such as a brochure, then the deliverable 
must be an item in Oracle Inventory. If the deliverable is an electronic file, then you 
must enter it into the database as an attachment first.

Steps
1. Navigate to the Deliverables check-list attribute.

2. If you have not created the deliverable, then click Create Deliverable and 
following the procedure in Creating Deliverables.

3. Use the Type drop-down list to select a deliverable type.

4. Use the Name list of values (LOV) to enter the deliverable you wish to attach to 
the campaign or event.

5. In the Quantity field, enter the number of deliverables you need. If you are 
creating an electronic deliverable such as a design for an advertisement or the 
text of an email sent to prospects, then enter the number 1. A numerical 
estimate is important only if the deliverable includes variable costs such as a 
printed brochure.

6. In Need by, enter the expected delivery date. This date is for information only.

7. Click Update. 

Tracking Costs Using the Costs Check-List Attribute
Use the costs check-list attribute to track costs. Using this attribute you can:

� Determine which costs you wish to track

� Enter costs

Determining Which Costs You Wish to Track
Use this procedure to determine which costs you wish to track using the Costs 
check-list attribute.

Prerequisites
You must set up the cost metrics before you can associate them with a campaign.
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Using the Metrics Check-List Attribute
Steps
1. Navigate to the Costs check-list attribute.

2. Select the Detailed radio button.

The available cost metrics appear in the Costs region.

3. Add additional cost metrics in the Create New region: 

a. In the Name field, click Go and use the list of values to select the cost 
metric.

b. Click Update.

Entering Costs
Use this procedure to enter the costs of your campaigns, events, and other objects in 
the Costs check-list attribute. 

Prerequisites
You must associate cost metrics to a campaign before you can enter costs. 

Steps
1. Navigate to the Costs check-list attribute.

2. Select the Input Only radio button.

The Costs region displays the cost metrics associated with this campaign. 

3. Enter the costs:

a. Using the Currency drop-down list, select the currency.

b. In the Actual column, enter the cost amount rounded to the nearest 
currency unit. Any fractions are rounded automatically.

c. Optionally, enter a forecast number.

d. Click Update.

Using the Metrics Check-List Attribute
You can use the metrics check-list attribute to:

� Determine which metrics you wish to use
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� Enter values into the metrics

Determining Which Metrics You Wish to Use
Use this procedure to associate metrics with a campaign, event, offer, or another 
object within Oracle Marketing Online.

Prerequisites
You must create the metrics before you can associate them with a campaign or 
another object.

Steps
1. Navigate to the Metrics check-list attribute.

2. Select the Detailed radio button.

The available metrics, if any, appear in the Metrics region.

3. Add additional metrics in the Create New region:

a. In the Name field, click Go and use the list of values to select the metric.

b. Click Create.

Entering Values into Metrics 
Use this procedure to enter values into metrics that allow manual entries. 

Prerequisites
You must create the metrics and associate them to a campaign, event, or another 
object first.

You can only enter values into metrics that allow manual entries.

Steps
1. Navigate to the Metrics check-list attribute.

2. Select the Input Only radio button.

The Metrics region displays the metrics associated with this object. 
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Entering and Viewing Notes
3. Enter metric values in the Actual and Forecast columns. 

4. Click Update.

Entering and Viewing Notes
Use this procedure to enter or view notes about an Oracle Marketing Online object 
such as a campaign, an event, a budget, or a message.

Prerequisites
None

Steps
1. Navigate to the Campaign Details subtab.

2. Click on the Notes check-list attribute.

The Campaign Details - Notes subtab appears.

3. You can view existing notes at the bottom of the window under the Note 
History heading.

4. If you wish to enter a note:

a. Select an optional Note Type.

b. Enter the note.

c. Click Update.

Guidelines
Notes you enter can be viewed from the campaign, event, or other object where you 
create them only. They cannot be viewed from other objects in the application. Only 
team member can view notes.

For example, If you enter a note for a rollup campaign, others in your team can only 
read the note when they view this rollup campaign. They cannot view the notes 
from the execution campaigns attached to the rollup campaign. 

Note: If the Metrics region does not appear, this means that there 
are no associated metrics which allow manual data entry.
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Using the Tasks Check-List Attribute
Using this check-list attribute you can:

� View tasks associated with the campaign, event or other object

� Assign tasks

Viewing Assigned Tasks Specific to a Campaign or Another Object
Use this procedure to view the assigned tasks for a campaign, event, or another 
object. This view shows all of the tasks assigned.

 If you wish to view only the tasks assigned to you, then navigate to Home > Tasks. 
See Viewing Tasks Assigned to You.

Prerequisites
None

Steps
1. Navigate to the Tasks check-list attribute. 

2. The subtab displays the tasks related to this object.

3. You can sort the tasks by priority or status using the drop-down lists or sort 
them by Name and Planned End Date.

Creating and Assigning Tasks for Specific Marketing Activities
Use this procedure to assign tasks for this specific marketing activity. The task you 
create is linked to the activity where you create it. For example, if you create a task 
while editing an event, that task will be linked to that event in the work queue of 
the individual you have assigned it to.

Prerequisites
None

Steps
1. Navigate to the Tasks check-list attribute. 

2. Click Create.

The Create Tasks subtab appears.
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Attaching Files
3. In Name, enter a few words describing the task. Think of this as the subject line 
of an email. You can be brief as you can explain the task in more detail later.

4.  As desired, classify the task with Type, Priority, and Status. 

5. In Planned End Date, enter a due date.

6. In Assignee, click Go and use the list of values to enter that name of the person 
to whom you are assigning the task.

7. Click Create.

8. Click on the task name to add a detailed description of the task and other 
details.

Adding a Description of a Task and Editing Task Details
Use this procedure to add a description and other details to a task you have created 
or to edit existing task information.

Prerequisites
You must create the task first.

Steps
1. Navigate to the Update Tasks subtab. You can reach it by clicking on a task 

name in the list of tasks. 

2. You can enter a detailed description explaining the task in the Notes text box. 

3. If you wish to keep this task private so it is not visible to others in your team, 
then select the Private check box.

4. Edit other fields.

5. Click Update. 

 Attaching Files
Use this procedure to save a file in the database and attach it to a campaign, event, a 
deliverable, or another object. An attachment can be a file of any size and type.

Prerequisites
None
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Granting Others the Right to Edit Your Campaign, Event, or Budget
Steps
1. Click on the Attachments attribute.

2. In an available row, click Go next to the Name field.

The Deliverable Attachment Selector dialog appears.

3. Click Browse and select the file you wish to enter into the database.

4. Click Upload.

If the file is large, you may be asked to wait for a few minutes.

5. Using the Type drop-down list, select the file type.

6. Click Update.

The file name you just entered will turn into a hyperlink indicating that the 
attachment has been created.

Granting Others the Right to Edit Your Campaign, Event, or Budget
Use this procedure to grant individuals or whole teams the right to edit your 
campaign, event, or budget by adding their names in the Team check-list attribute.

Prerequisites
None

Steps
1. Navigate to the Team check-list attribute.

The Team subtab appears.

2. If you wish to grant edit privileges to an individual, then, from the User/Role 
drop-down list, select User.

3. If you wish to grant edit privileges to a whole team, then, from the User/Role 
drop-down list, select Team.

Note: Individuals who you do not grant editing rights can view a 
summary of objects in the application displayed in their browsers, 
but they cannot view details such as notes and tasks and cannot 
make any changes. 
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Attaching a Marketing Message to Your Campaign or Event
4. Use the Name list of values (LOV) to enter the name of the person or team you 
are granting edit privileges.

5. If you wish this person or team to have permission to edit metrics of this 
campaign, then select the Metrics check box.

6. Click Update.

Specifying a Market Segment
Use this procedure to specify the market segment you wish to target with your 
campaign, event, offer, or budget. What you enter here is for informational 
purposes only. It does not trigger any seeded Oracle Marketing Online workflows.

Prerequisites
The market segments must already be created using Oracle Web Discoverer.

Steps
1. Navigate to the Market check-list attribute.

The Market subtab appears.

2. From the Type drop-down list, select the segment type.

3. In Segment Name, click Go and use the list of values to enter the segment. 

4.  Click Update.

Attaching a Marketing Message to Your Campaign or Event
Use this procedure to attach your campaign or event to a marketing message. 
Attaching a marketing message is another way of classifying you campaigns.

Prerequisites
The marketing message must be created before you can use it to classify a campaign 
or event.

Steps
1. Navigate to the Message check-list attribute.

The Message subtab appears.
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Scheduling Activities for Campaigns and Events
2. From the Message Type drop-down list, select the message type you wish to 
use.

3. Use the Message list of values (LOV) to enter the name of the message.

4. Click Update.

Scheduling Activities for Campaigns and Events
Use this procedure to schedule a campaign activity such as an email blitz or the 
calling of a particular segment of your audience. You can create multiple schedules 
for each campaign. 

If you wish to trigger an activity automatically when a specific condition becomes 
true, then you must instead create a trigger. When the condition becomes true, the 
trigger automatically creates a schedule for the activity and executes it. 

Prerequisites
You must create the campaign and marketing channel first.

Steps
1. Navigate to the Campaign Details subtab.

2. Click on the Schedules check-list attribute.

The Campaign Details - Schedule subtab appears.

3. Enter the range of dates you wish the activity scheduled. The date range must 
fall within the dates for the campaign. These are displayed at the top of the 
subtab.

4. Do not make any entries in the Source Code field. The application generates the 
unique identifier for the activity automatically.

5. Click Setup.

The Schedule Details window appears. You are now ready to enter details for 
the activity you wish to schedule.

References
About Executing Marketing Activities Through Schedules
44 Oracle Marketing Online Concepts and Procedures



Entering Details About a Campaign Schedule
Entering Details About a Campaign Schedule
Use this procedure to enter or edit information in a schedule you have created. A 
schedule is an activity you have scheduled.

Prerequisites
You must create the schedule before you can enter its details.

Steps
1. Navigate to the Schedule Details attribute of a campaign. You are taken here 

automatically when you create a schedule. Or you reach it by clicking on the 
Schedule attribute from the Details subtab of a campaign and selecting the 
schedule you wish to edit.

2. If you wish to modify the dates this schedule will remain effective, then modify 
the start and end dates. The dates must fall within the effective dates for your 
campaign.

3. If you wish to make a deliverable, such product collateral, available to 
individuals who will be carrying out this marketing activity, then select that 
deliverable using the Deliverable drop-down list. You must create and associate 
this deliverable with your campaign before it appears on this list. 

4. If you wish to make an offer available through your organization’s web site, call 
center, or through other means, then choose that offer using the Offer 
drop-down list. The offers that appear on this list are limited to the offers you 
have associated with this campaign in the Offers check-list attribute. See 
Creating Offers.

5. If this activity involves an outbound calling campaign and you wish the call 
center to use a script, then click Go in the Script field and use the list of values 
(LOV) to select the script. Scripts are created using Oracle Scripting, a separate 
application.

6. If you wish to specify the text of the email merge letter to be sent out to your 
customers, then:

a. In the Cover Letter field click Go and use the LOV to specify the merge 
letter. 

b. If you wish to specify the text of the subject line of the email, then enter it in 
the Subject text field.

c. Enter the email for the sender of the email.
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d. If you wish potential customers to reply to a different person than the 
sender, then enter that email address in the Reply To text field. 

7. In the Response region, enter information on where customers can go for more 
information: 

a. If you wish to publish a URL where customers can obtain more 
information, then enter that URL.

b. If you wish to give your customers an email address where they can obtain 
more information, then enter it in the Email field.

c. If you wish customers to call a particular number for more information, 
then enter the phone number.

d. If you wish your sales organization to use a script when talking to 
customers who call in, then enter it in the Script field by clicking Go and 
using the LOV.

8. In the Audience region, enter the lists of prospects or customers targeted by this 
activity. If you are creating an email blitz, then this is the list of people to be 
emailed:

a. Use the Name drop-down list to select the list.

b. If you wish the email campaign to be executed immediately, then select the 
Execute check list.

9. Click Update.

If you are creating an email blitz and you selected the Execute check box, then your 
email is mailmerged and sent automatically.

References
About Executing Marketing Activities Through Schedules

Note: The list you select must have the status of Active.

Note: After you have selected and executed a list for a campaign 
schedule, the status of the list is updated from Available to 
Locked. You cannot reuse the same list again with that or any 
other campaign schedule. If you want to use same list entries 
again, then create the new list.
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Creating Offers
Creating an Email Blitz

Entering Information About Campaign Geography
Use this procedure to enter in the Geography check-list attribute information that 
can help you track the geographical regions targeted by your campaigns. 

Prerequisites
The geographical regions you can enter here must be set up by your application 
administration or implementation team.

Steps
1. Navigate to the Campaign Details subtab.

2. Click on the Geography check-list attribute.

The Campaign Details - Geography subtab appears.

3. Using the Level drop-down list, select the level of the geographical area you 
wish to attach to this campaign.

4. In the Name field, click Go and use the list of values to enter the location for the 
level you selected in the previous step. 

5. Click Update.

6. Repeat this procedure for all of the geographical locations you wish to attach to 
the campaign.

Creating Offers
Use this procedure to create discounts and offers for campaigns using the Offer 
check-list attribute. 

Prerequisites
You can only create offers for existing campaigns.

Steps
1. Navigate to the Campaign Details subtab.

2. Click on the Offer check-list attribute.

The Campaign Details - Offer subtab appears.
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Entering the Details of an Accrual Offer
3. From the Type drop-down list select the type of offer you wish to create. 

4. Enter an offer name.

5. Enter a unique offer code.

6. Enter the dates the offer will remain active. These dates must fall within the 
active dates of your campaign.

7. Click Update.

8. If you wish to add details about the offer, then click Details and follow the 
procedure corresponding to the offer type you selected:

� Accrual

� Lump sum

� Off invoice

� Order value

� Promotional goods

Guidelines
See About Offers for a definition of offer types.

Entering the Details of an Accrual Offer
Use this procedure to enter the details about an accrual offer. 

Prerequisites
You must create an offer first.

Steps
1. Navigate to the Offer Details -- Accrual subtab. From the Offer attribute, you 

can do so by clicking Details next to the accrual offer you have created. 

2. Optionally, select a status.

3. Enter the dates customers can order using this offer. These dates must fall 
within the dates of the campaign.

4. Enter the dates customers can receive shipments for goods ordered with this 
offer. These dates must fall within the dates of the campaign.
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Entering the Details of an Accrual Offer
5. Do not make entries in Performance Dates Between fields. These are used for 
N-tier marketing.

6. If you wish to restrict the offer to a product family, then:

a. In the Product region use the Level drop-down list to select Product Family. 

b. The offer is valid for every product in the product family. If you wish to 
exclude certain products in the family from receiving this offer, then, after 
you complete this procedure, use the Products check-list attribute to 
exclude them. 

7. If you require the customer or prospect to purchase a minimum number of 
products before the offer applies, then:

a. In the UOM field, click Go and use the list of values (LOV) to enter the 
units used to measure the products. 

b. In Quantity, enter the minimum quantity your customer has to purchase for 
the offer to apply.

8. If you wish to tier the discounts, then select the Tiered? check box and follow 
the instruction on setting up tiered discounts using the Advanced Options 
check-list attribute.

9. In Base Rate, enter the amount of your discount either as an amount or as 
percent. You must select which you are entering from the drop-down list.

10. If there is a limit on the number of units of product an individual customer can 
buy using this discount, then enter that amount in the Maximum Cap field.

11. If you wish to limit the offer to only those customers within one or more market 
segments, then select the Market check-list attribute and enter the market 
segment(s). Limiting the offer to a market segment means that customers 
outside that market segment cannot take advantage of the offer, even if they 
have the offer code. 

12. Click Update.

13. Fill in information in the other check-list attributes on the left side of the screen. 
You can learn about each attribute by following the appropriate link in the 
Guidelines section.

Guidelines
The list below includes all check-list attributes used by offers. 
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Entering the Details of a Lump-Sum Offer
Depending on your implementation, only a subset of these attributes may be listed 
in the check list for your offer. 

� Advanced Options 

� Attachments 

� Budgets

� Costs 

� Metrics 

� Notes

� Products

� Tasks 

Entering the Details of a Lump-Sum Offer
Use this procedure to enter a lump-sum offer. This type of discount is used for 
N-tier marketing only. It provides the customer a lump sum amount as cash or 
accrual. This is usually payment for the customer’s promotional activities on your 
behalf.

Prerequisites
You must create an offer first.

Steps
1. Navigate to the Offer Details -- Lump Sum subtab. From the Offer attribute, you 

can do so by clicking Details next to the offer you have created. 

2. In the Performance Date fields enter the period of the promotional activity.

3. In the Lumpsum field, enter the amount to be paid to the customer.

4. From the Payment Type drop-down list, select either:

� Check: This issues a check to the customer.

� Accrue: This accrues the amount for later payment or use against 
short-payment of invoices.

5. Click Update.
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Entering the Details of an Off-Invoice Offer
Entering the Details of an Off-Invoice Offer
Use this procedure to enter the details about an off-invoice offer. 

Prerequisites
You must create the offer first.

Steps
1. Navigate to the Offer Details -- Off Invoice subtab. From the Offer attribute, you 

can do so by clicking Details next to the off-invoice offer you have created. 

2. Optionally, select a status.

3. Enter the dates customers can order using this offer. These dates must fall 
within the dates of the campaign.

4. Enter the dates customers can receive shipments for goods ordered with this 
offer. These dates must fall within the dates of the campaign.

5. Do not make entries in Performance Dates Between fields. These are used for 
N-tier marketing.

6. Specify the product or product family for this offer in the Product region:

a. From the Level drop-down list, select Product or Product Family. 

b. If this offer is valid for a single product only, then in the Product field, click 
Go and use the list of values to enter the product.

c. If you selected Product Family, then leave the product field blank. The offer 
is valid for every product in the product family. If you wish to exclude 
certain products in the family from receiving this offer, then, after you 
complete this procedure, use the Products check-list attribute to exclude 
them. 

7. In the UOM field, click Go and use the list of values (LOV) to enter the units 
used to measure the products. 

8. If you are not entering a tiered offer, then:

Note: You can only select one product or one product family for 
an offer. You can use the Products check-list attribute only to 
exclude individual products from a products family.
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Entering the Details of an Off-Invoice Offer
a. In Quantity, enter the minimum quantity your customer has to purchase for 
the offer to apply.

b. In Base Rate, enter the amount of your discount either as an amount or as 
percent. You must select which you are entering from the drop-down list.

9. If you wish to tier the discounts, then:

a. Leave the Quantity and Base Rate fields blank.

b. Select the Tiered? check box. 

c. After you complete this procedure you must follow the instruction on 
setting up tiered discounts using the Advanced Options check-list attribute.

10. If there is a limit on the currency value of the product an individual customer 
can buy using this offer, then enter that amount in the Maximum Cap field. This 
amount is for information only.

11. If you wish to limit the offer to only those customers within one or more market 
segments, then select the Market check-list attribute and enter the market 
segment(s). Limiting the offer to a market segment means that customers 
outside that market segment cannot take advantage of the offer, even if they 
have the offer code. 

12. Click Update.

13. Fill in information in the other check-list attributes on the left side of the screen. 
You can learn about each attribute by following the appropriate link in the 
Guidelines section.

Guidelines
The list below includes all check-list attributes used by offers. 

Depending on your implementation, only a subset of these attributes may be listed 
in the check list for your offer. 

� Advanced Options 

� Attachments 

� Budgets

� Costs 

� Metrics 

� Notes
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� Products

� Tasks 

Entering the Details of an Order-Value Offer
Use this procedure to enter the details about an order-value offer. This discount 
depends on the total value of the customer’s order. 

Prerequisites
You must create an offer first.

Steps
1. Navigate to the Offer Details -- Order Value subtab. From the Offer attribute, 

you can do so by clicking Details next to the off-invoice offer you have created. 

2. Optionally, select a status.

3. Enter the dates customers can order using this offer. These dates must fall 
within the dates of the campaign.

4. Enter the dates customers can receive shipments for goods ordered with this 
offer. These dates must fall within the dates of the campaign.

5. If you have multiple levels of discounts for a product or product family, then 
select the Tiered? check box. 

6. In the Discount Rules region, enter the discount level(s) for each product or 
product family:

a. In the From field, enter the minimum order amount that will trigger the 
discount.

b. In the To field, enter the order amount for the upper limit of the discount. 
Entry in this field is optional. 

c. In the Product field, click Go and use the list of values to enter the product 
or product family. If you wish to exclude individual products in the family 
from receiving this offer, then, after you complete this procedure, use the 
Products check-list attribute to exclude them. 

d. In UOM, click Go and use the list of values to enter the units of measure.

e. Enter discount either as a percentage or a currency amount.
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Entering the Details of a Promotional-Goods Offer
f. Repeat this procedure for each discount level and for each product or 
product family.

7. Click Update.

8. Fill in information in the other check-list attributes on the left side of the screen. 
You can learn about each attribute by following the appropriate link in the 
Guidelines section.

Guidelines
The list below includes all check-list attributes used by offers. 

Depending on your implementation, only a subset of these attributes may be listed 
in the check list for your offer. 

� Advanced Options

� Attachments 

� Budget

� Costs 

� Metrics 

� Notes

� Products

� Tasks 

Entering the Details of a Promotional-Goods Offer
Use this procedure to set up a promotional-goods offer. This type of offer bundles 
promotional goods along with customer purchases.

Prerequisites
You must create an offer first.

Steps
1. Navigate to the Offer Details --Promotional Goods subtab. From the Offer 

attribute, you can do so by clicking Details next to the promotional goods offer 
you have created.

2. If you wish to restrict the offer by the date the customer purchases the goods, 
then enter the date range in the Order Date From and To fields.
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Entering the Details of a Promotional-Goods Offer
3. If you wish to limit the offer by the ship date of the product purchased, then 
enter the date range in the Ship Date From and To fields.

4. If you wish to limit the offer by the performance date, then enter the date range 
in the Performance Date From and To fields.

5. In the Buy region, enter the products or product families the customer must 
purchase to trigger the offer. Make a separate entry for each product or product 
family that must be purchased to trigger the offer:

a. From the level In the Product field, click Go and use the list of values (LOV) 
to enter the product or product family. 

b. In Name, click Go and use the product LOV to enter the product or product 
family name.

c. If you have selected a product family, and wish to exclude individual 
products in the family from receiving this offer, then, after you complete 
this procedure, use the Products check-list attribute to exclude them. 

d. Enter the quantity of the product the customer must purchase to trigger the 
offer.

e. In Unit, click Go and use the product LOV to enter the units for the 
quantity.

6. In the Get region, enter information about the product or products customers 
receive if they make the purchases you specified in the Buy region:

a. In Name, click Go and use the product LOV to enter the product name the 
customer will receive.

b. Select the price list for the product.

c. Enter the number of units of the product the customer will receive.

d. In Discount, enter any discount either as an amount or percentage. 

7. Click Update.

8. Fill in information in the other check-list attributes on the left side of the screen. 
You can learn about each attribute by following the appropriate link in the 
Guidelines section.

Guidelines
The list below includes all check-list attributes used by offers. 
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Depending on your implementation, only a subset of these attributes may be listed 
in the check list for your offer. 

� Advanced Options 

� Attachments 

� Budgets

� Costs 

� Market

� Metrics 

� Notes

� Products

� Tasks 

Entering Advanced Details for Offers
You can use this check-list attribute to:

� Enter the discounts for a tiered off-invoice offer

� Enter advanced pricing information. If you wish to set up advanced pricing 
using this attribute, then refer to the Oracle Pricing documentation.

Entering the Discounts for a Tiered Off-Invoice Offer
Use this procedure to enter the details about the levels of discounts available in a 
tiered off-invoice offer using the Advanced Options attribute.

Prerequisites
You must have selected the Tiered? check box when you create the off-invoice offer.

Steps
1. Navigate to the Advanced Options attribute. 

2. Enter the discounts for the offer in the Discount rules region:. For each level of 
discount:

a.  In the From column, enter the quantity that triggers that level of discount. 

b. In the To column, enter the maximum quantity for this level of discount.
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c. If you are setting up a tiered discount for a product family, then use the 
Product list of values to specify the product for this level of discount and 
the UOM list of values for the units of measure.

d. In the Discount field, enter the amount or percentage of the discount. 

e. Repeat this procedure for each discount level.

3. Click Update.

Associating Products with Campaigns, Offers, and Events
You can use the Products check-list attribute to: 

� Specify products and product families you wish to either include or exclude 
from campaigns and events.

� Specify which individual products you wish excluded from an offer that covers 
an entire product family

Use this procedure to do both.

Prerequisites
You must create a campaign, event, or offer before you can associate products with 
it.

Steps
1. Navigate to the Products check-list attribute.

2. If you are setting up an offer and you have entered a product family in the 
Product region of the offer details subtab, then you can exclude individual 
products in that family from the offer. Here is how:

a.  From the Level drop-down list, select Product.

b. In Name, click Go and use the list of values to select the product you wish 
to exclude from the offer. The product must be from the same product 
family you have selected for your offer.

c. Select the Exclude check box.

d. Click Update.

3. If you are specifying products or product families to associate with campaigns 
or events, then:
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a.  From the Level drop-down list, select Product or Product Family.

b. In Name, click Go and use the list of values to select the product or product 
family you wish add to the offer. 

c. Click Update.

4. If you have specified a product family for a campaign or event and wish 
exclude individual products from that family, then:

a.  From the Level drop-down list, select Product.

b. In Name, click Go and use the list of values to select the product you wish 
to exclude from the offer. The product must be from one of the product 
families you have already entered.

c. Select the Exclude check box.

d. Click Update.

Triggering Campaign Actions Automatically
Use this procedure to automatically trigger a marketing action when a condition is 
met. For example, you can trigger an email blitz when the number of responses in 
another email blitz reaches a certain threshold or you can trigger an extra offer for 
items that have a large inventory. 

When a trigger executes, it automatically creates a schedule that is listed in the 
Schedule check-list attribute. 

Prerequisites
� Schedules and Triggers must appear among the list of attributes for your 

campaign. 

� In Campaign Details, you must enter a currency using the Budget Amount 
drop-down list before creating a trigger.

Steps
1. Navigate to the Campaign Details subtab.

2. Select the Trigger attribute.

3. The Campaign Details - Trigger subtab appears.

4. Using the Comparison Type drop-down list select a category for the trigger you 
wish to create. (See the guidelines for an explanation)
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5. Enter a name.

6. Enter dates the trigger will remain effective.

7. Click Setup.

You are now ready to enter details about the trigger. In the list below, click on 
the type of trigger you are creating for more information. 

� Date

� Metric to Metric

� Metric to Value

� Metric to Workbook

Guidelines
There are four types of triggers you can set up:

References
About Executing Marketing Activities Through Schedules

Entering Trigger Details
For details on how to set up a trigger, click on the hyperlink below corresponding to 
the trigger type:

� Date

� Metric to Metric

Comparison Type Function

Date Executes the action on the date indicated.

Metric to Metric Executes the action based on a comparison of two metrics. For 
example, if the number of responses in one execution campaign 
is greater than the responses of another. 

Metric to Value Executes the action based on a comparison of a metric with a 
number. For example, when the number of responses of the 
campaign are greater than 5,000.

Metric to Workbook Executes the action based on the results of an SQL query. For 
example, if the inventory of an item is greater than a certain 
number then the application applies a discount.
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� Metric to Value

� Metric to Workbook

Click here to see an example of how you can trigger an email blitz based on the 
response rate of another email blitz.

Entering Date Trigger Details
Use this procedure to enter or edit information required to trigger an email blitz on 
an a date and time you specify.

Prerequisites
� You must create the Date type trigger first.

� If you wish to trigger an mail blitz to a list of prospects, then you must create 
that list first.

Steps
1. Navigate to the Campaign Details - Trigger subtab:

� If you are in the process of creating a new trigger, then this subtab appears 
automatically when you click Setup.

� If you are editing a trigger, then drill down on the trigger name in the list 
that appears when you open the Trigger attribute.

2. If you wish to use a different time zone for the trigger, then make a selection 
from the Time Zone drop-down list.

3. Enter the date you wish the action triggered in the Start Date field.

4. Enter a time for the activity in the field to the right of the Start Date. Use the 
12-hour format (HH:MI PM).

5. Leave all other fields in the Monitor Setup region blank.

6. In the Action region, select the Send Notification to Owner check box if you 
wish to send a reminder to the owner of the campaign on the date you entered. 
The notification is sent to the Notifications section of the Personal Home Page.

7. If you wish to trigger an email to be sent to a list you have created, then:

a. Select the Generate List check box.

b. Enter the list name using the drop-down list to the right.
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c. If you wish to schedule the email blitz for immediate execution, then check 
the appropriate radio button.

d. If you must obtain approval first then select the Execute After Approval 
radio button, click Go and use the list of value to enter the name of the 
person who is to approve the email blitz.

8. Do not make entries in the Mail Preference region. You can enter all of the 
information in the schedule created automatically by this trigger. 

9. Click Update.

10. You are returned to the Campaign Details subtab.

11. Select the Schedule check-list attribute.

12. Click on the name of the schedule that you have just created. The name is the 
same as the trigger name.

13. Follow the procedure for entering schedule details to enter the information 
about the email to be sent out.

Entering Metric to Metric Trigger Details
Use this procedure to enter or edit information required to trigger an email blitz 
when a metric meets a certain condition.

Prerequisites
� You must create the metric-to-metric-type trigger first.

� If you wish to trigger an mail blitz to a list of prospects, then you must create 
that list first.

� The metric you wish to use as the basis for the condition must be associated 
with the campaign first.

Steps
1. Navigate to the Campaign Details - Trigger subtab:

� If you are in the process of creating a new trigger, then this subtab appears 
automatically when you click Setup.

� If you are editing a trigger, then drill down on the trigger name in the list 
that appears when you open the Trigger attribute.
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2. If you wish to use a different time zone for the trigger, then, in the Monitor 
region, make a selection from the Time Zone drop-down list.

3. In the Start Date field, enter the date you wish the trigger to start monitoring.

4. Enter a time to start monitoring to the right of the Start Date. Use the 12-hour 
format (HH:MI PM).

5.  If you wish to stop monitoring, then

a. In the End Date field, enter the date you wish the trigger to stop 
monitoring.

b. Enter a time to stop monitoring to the right of the End Date. Use the 
12-hour format (HH:MI PM).

6. Enter information on how frequently and when the condition is to be monitored 
by the concurrent program:

a. Enter a number in the Frequency field.

b. From the drop-down list, select the time period. Daily or weekly, for 
example.

c. In Daily Start Time and Daily End Time, enter the times when you wish to 
program to run.

7. In the Condition region, use the Metric Name drop-down list to select the 
metric you wish to use for the comparison. The metric must be associated with 
your campaign using the Metrics attribute for it to appear in this list.

8. Using the Metric Type drop-down list, select whether you wish to compare the 
actual, committed, or forecast value. The actual value is the value the metric has 
at the time the comparison is made.

9. From the Is drop-down list, select the operator for the comparison. For example, 
< for less than, or = for equal to.

10. Enter information about what you are comparing the metric to:

a. Use the Object Type drop-down list to select the type of object that contains 
the metric you are comparing to. This can be any object with the Metric 
check-list attribute, including a campaign and event. Selecting an object 
type restricts the list of values you use in the next step. 

b. In Object Name click Go and use the list of values (LOV) to select the object 
with the metric you wish to compare. The selection you make here 
determines what metric you can choose in the next step.
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c. Use the Metric drop-down list to select the metric for the comparison. Only 
the metrics associated with the object you selected in the previous step 
appear in this list.

d. Using the Metric Type drop-down list, select whether you wish to compare 
the actual, committed, or forecast value. The actual value is the value the 
metric has at the time the comparison is made.

11. In the Action region, select the Send Notification to Owner check box if you 
wish to send a reminder to the owner of the campaign on the date you entered. 
The notification is sent to the Notifications section of the Personal Home Page.

12. If you wish to trigger an email to be sent to a list you have created, then:

a. Select the Generate List check box.

b. Enter the list name using the drop-down list to the right.

c. If you wish to schedule the email blitz for immediate execution, then check 
the appropriate radio button.

d. If you must obtain approval first then select the Execute After Approval 
radio button, click Go and use the list of value to enter the name of the 
person who is to approve the email blitz.

13. Do not make entries in the Mail Preference region. You can enter all of the 
information in the schedule created automatically by this trigger. 

14. Click Update.

The trigger checks for the condition at the times you specified in Monitor Setup. If 
the condition is met, the trigger creates a schedule and executes the blitz or waits for 
approval, if you had selected that condition.

References
Click here to see an example of how you can trigger an email blitz based on the 
response rate of another email blitz.

Entering Metric to Value Trigger Details
Use this procedure to enter the details for a metric to value trigger.

Prerequisites
� You must create the metric-to-value-type trigger first.
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� If you wish to trigger an mail blitz to a list of prospects, then you must create a 
list of type template first.

� The metric you wish to use as the basis for the condition must be associated 
with the campaign first.

Steps
1. Navigate to the Campaign Details - Trigger subtab:

� If you are in the process of creating a new trigger, then this subtab appears 
automatically when you click Setup.

� If you are editing a trigger, then drill down on the trigger name in the list 
that appears when you open the Trigger attribute.

2. If you wish to use a different time zone for the trigger, then, in the Monitor 
region, make a selection from the Time Zone drop-down list.

3. In the Start Date field, enter the date you wish the trigger to start monitoring.

4. Enter a time to start monitoring to the right of the Start Date. Use the 12-hour 
format (HH:MI PM).

5.  If you wish to stop monitoring, then

a. In the End Date field, enter the date you wish the trigger to stop 
monitoring.

b. Enter a time to stop monitoring to the right of the End Date. Use the 
12-hour format (HH:MI PM).

6. Enter information on how frequently and when the condition is to be monitored 
by the concurrent program:

a. Enter a number in the Frequency field.

b. From the drop-down list, select the time period. Daily or weekly, for 
example.

c. In Daily Start Time and Daily End Time, enter the times when you wish to 
program to run.

7. In the Condition region, use the Metric Name drop-down list to select the 
metric you wish to use for the comparison. The metric must be associated with 
your campaign using the Metrics attribute for it to appear in this list.

8. From the Is drop-down list, select the operator for the comparison. For example, 
< for less than, or = for equal to.
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9. In the text box to the right of the operator, enter the value.

10. In the Action region, select the Send Notification to Owner check box if you 
wish to send a reminder to the owner of the campaign on the date you entered. 
The notification is sent to the Notifications section of the Personal Home Page.

11. If you wish to trigger an email to be sent to a list you have created, then:

a. Select the Generate List check box.

b. Enter the list of type Template name using the drop-down list to the right.

c. If you wish to schedule the email blitz for immediate execution, then check 
the appropriate radio button.

d. If you must obtain approval first then select the Execute After Approval 
radio button, click Go and use the list of value to enter the name of the 
person who is to approve the email blitz.

12. Click Update.

The trigger checks for the condition at the times you specified in Monitor Setup. If 
the condition is met, the trigger creates a schedule and executes the blitz or waits for 
approval, if you had selected that condition.

Entering Metric to Workbook Trigger Details
Use this procedure to enter the details for a metric to value trigger.

Prerequisites
� You must create the metric-to-workbook-type trigger first.

� If you wish to trigger an mail blitz to a list of prospects, then you must create a 
list of type template first.

� The metric you wish to use as the basis for the condition must be associated 
with the campaign first.

Steps
1. Navigate to the Campaign Details - Trigger subtab:

� If you are in the process of creating a new trigger, then this subtab appears 
automatically when you click Setup.

� If you are editing a trigger, then drill down on the trigger name in the list 
that appears when you open the Trigger attribute.
Using Oracle Marketing Online 65



Entering Metric to Workbook Trigger Details
2. If you wish to use a different time zone for the trigger, then, in the Monitor 
region, make a selection from the Time Zone drop-down list.

3. In the Start Date field, enter the date you wish the trigger to start monitoring.

4. Enter a time to start monitoring to the right of the Start Date. Use the 12-hour 
format (HH:MI PM).

5.  If you wish to stop monitoring, then

a. In the End Date field, enter the date you wish the trigger to stop 
monitoring.

b. Enter a time to stop monitoring to the right of the End Date. Use the 
12-hour format (HH:MI PM).

6. Enter information on how frequently and when the condition is to be monitored 
by the concurrent program:

a. Enter a number in the Frequency field.

b. From the drop-down list, select the time period. Daily or weekly, for 
example.

c. In Daily Start Time and Daily End Time, enter the times when you wish to 
program to run.

7. In the Condition region, use the Metric Name drop-down list to select the 
metric you wish to use for the comparison. The metric must be associated with 
your campaign using the Metrics attribute for it to appear in this list.

8. From the Is drop-down list, select the operator for the comparison. For example, 
< for less than, or = for equal to.

9. Using the Workbook field to the right of the operator, select the workbook you 
are comparing the metric to.

10. In the Action region, select the Send Notification to Owner check box if you 
wish to send a reminder to the owner of the campaign on the date you entered. 
The notification is sent to the Notifications section of the Personal Home Page.

11. If you wish to trigger an email to be sent to a list you have created, then:

a. Select the Generate List check box.

b. Enter the list of type Template name using the drop-down list to the right.

c. If you wish to schedule the email blitz for immediate execution, then check 
the appropriate radio button.
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d. If you must obtain approval first then select the Execute After Approval 
radio button, click Go and use the list of value to enter the name of the 
person who is to approve the email blitz.

12. Click Update.

The trigger checks for the condition at the times you specified in Monitor Setup. If 
the condition is met, the trigger creates a schedule and executes the blitz or waits for 
approval, if you had selected that condition.

Handling Responses to a Campaign or Event
Use this procedure to set up response handling for an execution campaign or an 
execution event using the Response check-list attribute.

Prerequisites
None

Steps
1. Navigate to the Response check-list attribute.

2. If prospects will reply to the campaign or event over the phone, then: 

a. Use the Script list of values (LOV) to select the appropriate script 
telemarketers will use to talk to the prospects.

b. Enter the phone number the prospects are to call in the Phone field.

3. If prospects are replying by email, then enter the email address.

4. If prospects are to reply on a web site, then enter the URL.

5. Click Update.

Entering Information About Partners
Use this procedure to enter a list of partners using the Partner check-list attribute.

Note: You can only attach a script that has been created first using 
Oracle Scripting. You cannot create a script within Oracle 
Marketing Online.
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Prerequisites
None

Steps
1. Navigate to the Campaign Details subtab.

2. Click on the Partner check-list attribute.

The Campaign Details - Partner subtab appears.

3. In Name, click GO and use the list of values to enter a partner name.

4. Click Update.

5. Repeat this procedure to add additional partners.

Getting Approval for Your Campaign Theme
Use this procedure to obtain approval from your supervisor for a campaign you 
have created.

Prerequisites
� You must create a campaign first. 

� The application administrators must enable the approval work flows when they 
set up the campaign type. 

Steps
1. Navigate to the Campaign Details subtab of the campaign that needs to be 

approved.

2. From the Status drop-down list, select Planned.

The status becomes "Pending Theme Approval" and the application sends a 
message with your request and basic campaign information to your supervisor.

You receive a notification in your Personal Home Page after your supervisor 
approves or rejects your campaign theme. If the campaign theme has been rejected, 
the status becomes "Denied Theme Approval". If it has been approved, the status 
becomes "Planned."

See Also
How campaigns are approved
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Getting Approval for Your Campaign Budget
Use this procedure to obtain approval for your campaign budget. 

Prerequisites
� You must obtain a campaign theme approval before requesting a budget 

approval.

� The application administrators must enable the approval work flows when they 
set up the campaign type. 

Steps
1. Navigate to the Campaign Details subtab of the campaign that needs to be 

approved.

2. Make sure you enter the budget source and budget amount you are requesting.

3. From the Status drop-down list, select Active.

The Status changes to "Pending Budget Approval" and the application sends a 
message with your request and basic campaign information to the owner of the 
budget you are requesting.

You receive a notification in your Personal Home Page after the budget owner 
approves or rejects the budget. If the budget has been rejected, then the status 
becomes "Denied Budget Approval". If it has been approved, the status becomes 
"Active."

See Also
How campaigns are approved

Copying a Campaign
Use this procedure to copy an existing rollup or execution campaign.

Prerequisites
The campaign must be listed under My Campaigns indicating you have permission 
to copy it.

Steps
1. Navigate to the Campaign tab.
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2. Select the hyperlink for the campaign to be copied. 

The Campaign Details subtab appears.

3. Click Copy. 

The Copy Campaign window appears.

4. Make sure that the campaign you wish to copy appears in the Source Campaign 
field. If it does not, then select it using the list of values (LOV).

5. Enter the name for the new campaign. 

6. Do not enter a Source Code. This field will be populated by the application 
automatically. 

7. Enter the date the new campaign is to become effective.

8. In the Select Attributes for Copying region, select the check boxes of the 
attributes you wish to copy to the new campaign. Only the attributes that are 
populated with data appear on this list.

9. Click Copy Now. 

The new campaign is created.

10. Navigate back to the main Campaign tab by clicking on it.

11. Drill down on the hyperlink of the new campaign you have created.

12. Attach the campaign to a new place in the campaign hierarchy by making an 
entry in the Parent field. 

13. Edit the details for the new campaign.

Using the Deliverables Tab
Use the Deliverable tab to store and track the electronic files for your creative 
projects and campaigns. You can also use it to keep track of physical collateral in 
your inventory. 

You can obtain help on how to:

� View and edit a deliverable

� Create a deliverable

� Create a kit of deliverables
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 Viewing and Editing a Deliverable
Use this procedure to view and edit an existing deliverable.

Prerequisites
None

Steps
1. Navigate to the Deliverable tab.

2. If you do not see the deliverable you wish to view or edit among those 
displayed in the list, then search for it by changing the View, or using 
QuickFind and Advanced Search.

3. Click on the hyperlink of the deliverable you wish to view or edit.

The Deliverable Details subtab displays. You are now ready to edit the deliverable 
information.

Creating Deliverables
Use this procedure to create deliverables that you can associate with campaigns or 
events.

Prerequisites
None

Steps
1. Navigate to the Deliverable tab.

2. Click Create.

The Create Deliverable subtab appears.

3. Enter a unique name.

4. Enter a version for the deliverable. Usually this number will be 1 because you 
are creating a new deliverable.

Note: Oracle Marketing Online does not support versioning. If 
you enter a new version of a deliverable in the future, it will 
overwrite the previous version.
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5. Select a status.

6. In Available From and Available To fields, enter the dates this deliverable will 
be available for editing and use.

7. In Due Date, enter the deadline for this deliverable. The deadline must fall on or 
before the Available From date.

8. If you do not wish others in your organization to view or edit this deliverable, 
select the Private check box.

9. Select a language if other than American English.

10. Classify the deliverable using the Type and Subtype drop-down lists.

11. If you wish the owner to be someone other than yourself, use the Owner list of 
values (LOV) to select a different person.

12. In Budget Amount, enter the currency and the budget for this deliverable.

13. Enter a description.

14. Click Create.

You are now ready to enter the detailed information about the deliverable, this 
includes storing of associated electronic files as attachments.

Entering or Editing Detailed Deliverable Information
Use this procedure to enter or edit information about a deliverable.

Prerequisites
You must create the deliverable first.

Steps
1. Navigate to the Deliverable tab.

2. If you do not see the deliverable you wish to view or edit among those 
displayed in the list, then search for it by changing the View, or using 
QuickFind and Advanced Search.

3. Click the deliverable hyperlink.

Note: You can edit all fields of deliverables except for the Due 
Date. This can only be changed by an administrator.
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The Deliverable Details subtab appears.

4. If you are creating a new version of a deliverable, then enter a new version 
number. 

5. Edit fields as desired. 
 

6. If you are creating a deliverable that includes electronic files, then attach those 
files by clicking the Attachment check-list attribute and following the 
instructions for creating an attachment.

7. Fill in information in the other check-list attributes on the left side of the screen. 
You can learn about each attribute by following the appropriate link in the 
Guidelines section.

Guidelines
The list below includes all check-list attributes used for rollup events. 

Only a subset of these attributes may be listed in the check list for your event. This 
is because different types of events track different types of information. 

� Budgets: This is where you request funds for the deliverable.

� Inventory and Kit: Use this attribute to create a kit and enter it into inventory.

� Attachments 

� Costs

� Metrics 

� Notes 

� Tasks 

Creating a Kit of Deliverables
Use this procedure to compile a number of deliverables into a kit. The kit itself must 
be created as a deliverable first before you can add deliverables to it.

Note: Oracle Marketing Online does not support automatic 
versioning. If you are entering a new version of a deliverable, it will 
overwrite the previous version.
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Prerequisites
You must create the kit as a new deliverable first.

Steps
1. Navigate to the Inventory and Kit check-list attribute for the deliverable you 

have created for the kit. This attribute appears among the check-list attributes in 
the Deliverable Details subtab.

2. If the kit is made up of electronic files, then select the Managed Electronically 
radio button.

3. If the kit is made up of physical collateral, then:

a. Select the Managed Physically radio button.

b. If you are keeping the kits as part of inventory, then select the Stock 
Manually radio button and enter the quantity you have in the Quantity 
field.

c. If the kit is to become an inventory item, then enter an inventory part 
number in the Part Number field.

4. In the Kit region, enter the deliverables that are a part of this kit:

a. Using the Name list of values, enter the name of the deliverable.

b. Click Update.

c. Repeat this procedure for each deliverable in the kit.

5. Click Update.

Using the Event Tab
Use the Event tab to manage marketing events.

You can obtain help on how to:

� View and edit a rollup event

� View and edit an execution event

� Create a rollup event

� Create an execution event

You can obtain more information about events in:

� Understanding events
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Viewing and Editing a Rollup Event
Use this procedure to view and edit an existing rollup event.

Prerequisites
None

Steps
1. Navigate to the Event tab.

2. If you do not see the event you wish to view or edit among those displayed in 
the list, then search for it by changing the View, or using QuickFind and 
Advanced Search.

3. Click on the hyperlink of the event you wish to view or edit.

The Event Details subtab displays. You are now ready to edit the rollup event 
information.

Viewing and Editing an Execution Event
Use this procedure to view and edit an existing execution event.

Prerequisites
None

Steps
1. Navigate to the Event > Execution Event subtab.

2. If you do not see the execution event you wish to view or edit among those 
displayed in the list, then search for it by changing the View, or using 
QuickFind and Advanced Search.

3. Click on the hyperlink of the execution event you wish to view or edit.

The Event Details subtab displays. You are now ready to edit the execution event 
information.

Creating a Rollup Event
Use this procedure to create a rollup event. A rollup event holds the general 
description of an event and provides the structure for reporting costs and 
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dispersing budgets to individual sessions of the event. If your company is planning 
to train the sales force in different cities on your new product line, for example, then 
the rollup event holds information about the course content and the budgets for the 
individual sessions to be held in the different cities.

Prerequisites
None.

Steps
1. Navigate to the Events tab.

2. Click on the Events subtab.

3. Click Create. 

The Create Event subtab appears.

4. Use the Setup Type drop-down list to select the type of event you wish to 
create. Selecting a type determines which information you are required to enter. 
These types are set up by your administrator. 

5. Leave the Source Code field blank. It gets filled automatically with a unique 
code after your event gets created.

6. Enter a name for the event according to naming conventions for your 
organization.

7. Enter the start date and end date you wish this event to be available for use.

8. Optionally, enter the duration of the event. 

9. If you are not the person who is approving budgets or other activities for this 
event, then you must enter that person in the Owner field.

10. Enter a description of the event.

11. Click Create.

The Rollup Event Details window appears. You are now ready to enter details 
for this rollup event.

Entering or Editing Information for a Rollup Event
Use this procedure to add or to edit details for a rollup event you have created. 
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Prerequisites
You must create a rollup event before entering its details.

Steps
1. Navigate to the Rollup Event Details window.

2. Enter the budget source and budget amount. The entry you make in this field 
determines how the budget for this event is rolled up passed on for approvals. 
Usually, the budget for the event comes from a rollup campaign.

3. Select applicable check boxes:

� Confidential: The information is not released on any web site or 
telemarketing application.

� Invite Only

� Registration Required 

� Payment Required 

4. Fill in information in the different check-list items, called attributes, on the left 
side of the screen. You can learn about each attribute by following the 
appropriate link in the Guidelines section.

Guidelines
The list below includes all check-list attributes used for rollup events. 

Only a subset of these attributes may be listed in the check list for your event. This 
is because different types of events track different types of information. 

� Attachments 

� Campaign

� Costs

� Deliverable

� Event Agenda

� Execution Event

� Market

� Message 

� Metrics 
Using Oracle Marketing Online 77



Promoting an Event by Associating It with a Campaign
� Notes 

� Partner

� Products

� Resource

� Response

� Tasks 

� Team 

Promoting an Event by Associating It with a Campaign
You can promote an event by creating a campaign for it and associating the event 
with that campaign. Use this procedure to associate the event with a campaign you 
have created.

Prerequisites
You must create the campaign before you can associate it with an event.

Steps
1. In the Rollup Event Details subtab, click on the Campaign attribute.

The Rollup Event Details - Campaigns subtab opens.

2. Use the Campaign Name list of values (LOV) to enter the campaign you wish to 
associate with the event. 

3. Click Update to save your work.

Entering an Event Agenda
Use this procedure to enter the agenda for a rollup or execution event. If your event 
has multiple activities happening at the same time, you can split up your event into 
separate tracks.

If you create an agenda for a rollup event, then that agenda is automatically copied 
to the execution events you link to that rollup event. You can then modify each 
execution event agenda to add details pertinent to the specific execution event. If 
you choose to create an agenda for an execution event, then that agenda is valid 
only for that execution event.
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Prerequisites
You must create a rollup event or a an execution event before you can enter its 
agenda.

Steps
1. For each item on the agenda for your event:

a. If your event takes place over a number of days, then select the day of the 
event.

b. In the Name field, enter the name of the activity.

c. If the activity is happening at the same time as another activity, then select a 
track for it that is different from the existing activity.

d. Enter a start time and end time for the activity. Times must be in the 
12-hour format (HH:MI PM).

2. Click Update.

3. In the Details column, click the Setup hyperlink to the right of each agenda item 
you have created and enter any speaker information and notes you may have 
for the item.

Entering Speakers and Other Details for an Event
Use this procedure to enter the speaker and other details for an agenda item in your 
event. 

Prerequisites
You must set up the agenda for an event before you can enter details.

Steps
1. Navigate to the Rollup Event Details - Agenda Details window.

2. If the agenda has a coordinator, then enter it in the Coordinator field.

3. If you have a speaker for this agenda item, then click Go next to the Name field 
and use the list of values (LOV) to enter the speaker’s name.

4. From the Status drop-down list, select the confirmation status for the speaker.

5. Enter any optional comment in the comment field. 

6. If you wish to enter a note, then:
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a. Using the drop-down list, select the note type.

b. Enter the note.

c. Click Update.

Entering Event Venues, Coordinators, and Other Resources
Use this procedure to enter venues, coordinators and other resources for your event. 

Prerequisites
You must set up venues before you can associate them with an event.

Steps
1. Navigate to the Rollup Event Details - Agenda Details window.

2. Using the Type drop-down list, select the type of resource you wish to associate 
with the event.

3. If the resource you are assigning to this event is a person, then enter the 
person’s name and role.

4. Select a status from the Status drop-down list.

5. Click Update.

Creating an Execution Event
Use this procedure to create an execution event. An execution event allows you to 
create specific sessions of events and to track participation and enrollment in each.

Prerequisites
You must create rollup event before you can use this procedure.

Steps
1. Navigate to the Create Execution Event subtab, Event >Execution Event. While 

creating a rollup event you can navigate here from the Rollup Event Details 
window by clicking the Execution Event attribute hyperlink.

2. In Event Name, enter the name of the rollup event you are associating this 
event with.

3. In the Execution Event Name field, enter the name of the event.
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4. Select the type of event.

5. If the person responsible for this event is other than yourself, enter that person’s 
name in the Owner field.

6. From the Setup Type drop-down list, select the custom setup for the event. The 
custom setup is created by the application administrator and determines the 
type of information you can track with an execution event.

7. Make entries in other optional fields.

8. Click Create.

The Execution Event Details window appears. You are now ready to enter 
detailed information for the event you have created.

Entering Details for an Execution Event
Use this procedure to enter or modify details about an execution event you have 
created.

Prerequisites
You must first:

� Create rollup event 

� Create an execution event 

� Create a venue for the execution event

Steps
1. Navigate to the Execution Event Details subtab. This subtab appears 

automatically when you create a new execution event. You can also reach it by 
the following method:

a. Navigate to Event > Execution Event

b. Select the hyperlink for the execution event you wish to modify.

c. Select the General check-list attribute.

2. Enter the budget source for this event:

a. Use the Budget Source drop-down list to select the budget type. If the 
budget comes from the rollup event, then select rollup event.
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b. Use the Budget Source list of values (LOV) to select the rollup event or 
other budget source. 

3. The Source Code field is automatically populated with the unique identifying 
code generated by the application for this execution event. Do not modify it 
unless you are instructed otherwise by your application administrator.

4. Enter the start and end dates when this event will be available for use.

5. Enter the duration of the event.

6. In Facility, use the LOV to enter the venue where the event is to be held.

7. Make entries in other optional fields, as desired.

8. Select applicable check boxes:

� Confidential: the information is not released on any web site or 
telemarketing application.

� Invite Only:

� Registration Required: 

� Payment Required:

9. Click Update.

10. Fill in information in the different check-list items, called attributes, listed on 
the left side of the screen. In the list below, click on a hyperlink corresponding 
the attribute you wish to learn more about. 

Guidelines:
The list below includes all check-list attributes used for rollup events. 

Only a subset of these attributes will be listed in the check list for your event. This is 
because different types of events need to track different types of information. 

� Attachments 

� Campaign

� Costs 

� Deliverable

� Event Agenda

� Invite List

� Market
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� Message 

� Metrics 

� Notes 

� Partner

� Products

� Publishable Notes

� Registration

� Resource

� Response

� Tasks 

� Team 

Setting Up Event Registration
Use this procedure to specify registration details for an execution event. This 
includes determining enrollment numbers and pricing. 

Prerequisites
You must create an execution event first.

Steps
1. Navigate to the Execution Event Details subtab and select the Registration 

hyperlink.

The Execution Event Registration Setup window appears.

2. In the Maximum Size field, enter the maximum number of registrants.

3. If you wish to limit registration to the number of registrants you entered in the 
Maximum Size field, then select the No Overbooking radio button.

4. If you wish to allow people to continue to register for the event regardless of the 
number you entered in the Maximum Size field, then select the Allow 
Overflow radio button. 
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5. If you wish Oracle Marketing Online to automatically create a new session of 
your execution event after the number of registrants has passed the number you 
have entered in the Maximum Size field, then:

a. Select the Overbook by radio button. 

6. Enter the percentage of overbooking to trigger the new session. For example, if 
the maximum number of registrants is 100 and you enter 10% then the 
application will allow up to 110 people to attend your original event. The 111th 
person is automatically enrolled in a new session as are all the subsequent 
enrollees. If you wish to continue to allow registrant application even when 
registration is full, then:

a. Select the Waitlist Enabled check box.

b. Specify the allowed size of the waitlist by entering a percentage value in the 
Waitlist field. 

c. Select a waitlist rule. The default is First Come First Serve: the first person 
on the waiting list gets the first available place. 

7. Enter the minimum size for this event. This number can be used to trigger a 
cancellation of the event or further campaign activity if you do not meet the 
minimum enrollment by the date you enter in the Attain Minimum By field. 

8. In Attain Minimum By field, enter a date by which the event must reach a 
minimum enrollment. 

9. Select the enrollment start day and time.

10. Enter the enrollment end day and time.

11. Specify the time zone to further clarify the dates and times.

12. If you are charging for the event, then enter the cost and payment details. This 
information will be added to your inventory:

a. If the attendee cost is based on a price list, select the applicable price list.

b. If you wish to enter an event price, then enter an amount and the applicable 
currency.

c. For a non-cash payment, select the credit type that is accepted for payment. 
Enter any credits that are accepted.

d. Enter the number that will be the inventory number for this event. 

13. If your organization uses a credit system such as that used at colleges and 
universities for classes, then:
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a. From the Credit Type drop-down list, select the type of credits used.

b. Enter the number of credits for this event.

14. If you wish to view the status of registration, then click the View List hyperlink.

15. Click Update to save these details.

Viewing the Status of Registration for an Event
Use this procedure to view the status of a registration for an event.

Prerequisites
Registration for your event must be handled by a related application such as Oracle 
TeleSales or imported into Oracle Marketing Online.

Steps
1. Navigate to the Execution Event Details subtab and select the Registration 

hyperlink.

The Execution Event Registration Setup window appears.

2. Click the View List hyperlink at the bottom of the window.

Execution Event Details - Registration List subtab appears displaying the 
registrants for your event and their status.

Publishing Event Notes on Your Web Site
Use this procedure to publish notes about an execution event on your company’s 
web site. You cannot use Oracle Marketing Online to specify the presentation of the 
information you wish to publish. You can only use it to enter the text.

Prerequisites
Your application must be configured to work with your web site via a product such 
as Oracle iStore.

Steps
1. Navigate to the Execution Event Details subtab and select the Publishable Notes 

hyperlink.

The Execution Event Details - Notes subtab appears.
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2. If you wish to view an existing note, then click on the note hyperlink at the 
bottom of the window under the Note History heading.

3. If you wish to enter a note to be published, then:

a. Select an optional Note Type.

b. Enter the note.

c. Click Update.

Specifying the Invitation List for an Execution Event
Use this procedure to specify the list of people you wish to invite to your execution 
event.

Prerequisites
You must create the list of invitees first before you can attach it to the execution 
event. 

Steps
1. Navigate to the Execution Event Details subtab and select the Invite List 

hyperlink.

The Execution Event Details - Invitation List subtab appears.

2. Use the List Name list of values (LOV) to enter the list name.

3. Click Update.

Using the Budget Tab
Use the budget tab to set up budgets that are used to pay for campaigns, offers, 
events, and deliverables. If you wish to draw funds from an existing budget, then 
use the Budget check-list attribute in campaign, event, or deliverable instead. 

You can obtain help on how to:

� Create a budget

� Edit budget information

� Allocate budgets

� Check how budgets are spent
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� Request the transfer of funds from one budget to another

For more information on budgets see:

� Understanding Budgets

Creating a Budget
Use this procedure to create a budget.

Prerequisites
None

Steps
1. Navigate to the Budget tab

2. Click Create. 

The Create Budget subtab appears.

3. Enter the budget name.

4. In Number, enter a unique identification number.

5. If this budget is subordinate to another budget, then click Go in the Parent field 
and use the list of values to enter the parent budget.

6. In Budget Amount, enter an amount. You entry must be a whole number. No 
spaces, commas or decimal points are allowed.

7. If the budget is in a currency other than the one shown in the Currency field, 
then select that currency from the drop-down list.

8. In Holdback Amount, enter the amount you wish to use as a reserve.

9. From the Category drop-down list, select a budget category.

10. Use the Department drop-down list to select your department.

11. If you are not the owner of this budget, then, in Owner, click Go and use the list 
of values to select a different owner.

12. Leave Status as Draft. The status will be updated automatically when you 
create the budget.

13. Enter the dates the budget is to remain active.
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14. Unless you are working in N-tier marketing, do not make entries in the General 
Ledger and Accrual Parameters.

15. Click Create to create the budget.

16. The Budget Details subtab appears. You are now ready to enter details about 
your budget.

Entering or Editing Budget Information
Use this procedure to edit or enter budget information for a budget you have 
created.

Prerequisites
None

Steps
1. Navigate to the Budget tab. If you have just created a budget, then this subtab 

opens automatically, otherwise you can navigate to it by clicking on the name of 
the budget you wish to edit in the Budget tab. 

2. Fill in information in the different check-list items, called attributes, listed on 
the left side of the screen. In the guidelines below, click on a hyperlink 
corresponding the attribute you wish to learn more about. 

3. You can edit information in all the fields in this subtab. These are the same 
fields you filled out when you created the budget. The guidelines section 
describes the fields.

4. Click Update.

Guidelines:
The list below includes all check-list attributes used for budgets. 

� Allocation 

� Checkbook 

� Market

� Notes 

� Products

� Team 
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Here are the fields you can edit:

Allocating Budgets
This check-list attribute is for use by N-tier marketing customers only to allocate 
budgets according to sales territory.

No help is available for this feature at this time.

Checking How A Budget is Spent 
Use this procedure to see how much money is left in a budget and how the money 
has been spent.

Field Description

Name Unique budget name.

Parent Name Name of a budget this budget is derived from. Make an entry 
here if you are creating a budget hierarchy.

Budget Amount The currency amount of your budget. You entry must be a whole 
number. No spaces, commas or decimal points are allowed.

Holdback Amount  The amount you wish to use as a reserve.

Category Budget category. Categories are determined by your 
implementation team.

Department Your department.

Owner The person who owns the budget approves any charges against 
that budget.

Active From /Active To Budget effective dates.

Status Triggers Workflow approval. Changing the status to Active 
requests approval from your manager.

Expense Account Reserved for N-tier marketing.

Accrual Account Reserved for N-tier marketing.

Basis Reserved for N-tier marketing.

Accrual Cap Reserved for N-tier marketing.

Rate Reserved for N-tier marketing.
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Prerequisites
None

Steps
1. Navigate to the Checkbook check-list attribute:

a. If you have just created a budget, then the Budget Detail subtab opens 
automatically, otherwise you can navigate to it by clicking on the name of 
the budget you wish to edit in the Budget tab.

b. Click the Checkbook check-list attribute.

2. If you wish to view further details on the total, planned, committed, earned, or 
paid amounts, you can do so by clicking on the currency amounts in those lines. 
Each of these currency amounts is hyperlinked to a report which appears in a 
separate subtab.

Requesting Transfer of Funds from One Budget to Another
Budget creators can use this procedure to request the transfer funds from one 
budget to another.

Prerequisites
You must have permission to create budgets. Both budgets must have the status of 
active for you to be able to transfer funds between them. If a budget has the status 
of new, then you can edit the budget amount directly without asking for a transfer.

Steps
1. Navigate to the Budget > Budget Transfer.

2. The Budget Transfer subtab appears.

3. Click Go in the Name field and use the list of values (LOV) to enter the budget 
you are transferring funds from.

The owner and remaining funds appear for the budget you selected.

4. In Requested Amount, enter the amount of the budget you wish to transfer.

5. In Transfer To, click Go and use the LOV to enter the budget you wish to 
transfer funds to.

6. Click Transfer.
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7. If you are the owner of both budgets, then the budget amount is transferred 
automatically:

a. The Budget Transfer confirmation subtab appears.

b. Click OK.

8. If you are not the owner of the budget, then your request is submitted to the 
budget owner and your supervisor for approval. The amount if transferred on 
their approval.

Guidelines
Understanding Budgets

Using the Audience Tab
Use this tab to create and manage lists. 

You can obtain help on how to:

� View a List

� Create a list

� Import a list

� Create and edit target and market segments

� Create a list import mapping template

For an understanding of the audience tab and how it interacts with Oracle Web 
Discoverer see:

� About List Types and Templates

� About Creating Lists

� About Workbooks, Worksheets, and Oracle Web Discoverer

Viewing and Revising a List 
Use this procedure to view and revise a list you have created.

Prerequisites
If you wish to view the list, it must be already generated.
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Steps
1. Navigate to Audience > Audience. 

2. Select the name hyperlink for the list you wish to view or edit.

The List Details subtab appears.

3. If you wish to view the list that has been generated, then click the View List 
Entries hyperlink. You can only view a list with a status of Active. This 
indicates that the list has been generated.

4. If you wish to edit any of the criteria used to generate the list, refer to the 
procedure found in Creating a List.

Creating a List 
Use this procedure to create a list of targets for your campaigns and lists of invitees 
for your events. Depending on your installation, you can use lists for email 
campaigns you set up in Oracle Marketing Online, for telemarketing execution 
through Oracle TeleSales, for direct mail campaigns through third-party mail-merge 
programs, for iMarketing execution over the Web, or for face to face sales through 
Oracle Sales Online.

You can create lists from queries that you have built in Oracle Web Discoverer or 
from other lists. 

Prerequisites
The sources for your list must be created first. Sources include workbooks you 
create in Oracle Web Discoverer or other lists you have created in the past.

Steps
1. In the Audience tab, click Create. 

The Create List screen appears.

2. If are using Oracle Web Discoverer workbooks to create your list and you have 
not created them yet, you must do so now by clicking Web Discoverer and 
following the procedure outlined in Creating Workbooks in Web Discoverer. 

3. Enter the list name. 

4. From the Type drop-down list, select the type of list you are creating:

a. If you are scheduling the list for immediate execution through a campaign 
schedule or an execution event, then select Target. 
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A target list queries the database and generates a fixed list of customers or 
prospects. 

Use this list type to invite prospects and customers to an event by 
associating the list with an execution event or to execute mail blitzes and 
other marketing activities using the campaign schedule check-list attribute.

b. If you are creating a list for execution via a trigger or creating a list that you 
will reuse in the future, then select Template. 

Templates store both the current list of customers as well as the query 
criteria used to generate that list. Every time you copy or use the template, 
the query is run automatically and the list is refreshed from the database. 
This assures that you are using the most up-to-date list of customers and 
prospects. 

5. From the Status drop-down list, select a status for the list. See guidelines below 
for more information about list status. 

6. Use the Association Type drop-down list to specify whether this list is going to 
be associated with a campaign or an event.

7. Enter an optional description.

8. If you wish to create a list from a single workbook or target segment, then in the 
Selection Criteria region:

a. Using the Type drop-down list, select whether you are using a workbook or 
a target segment.

b. Use the Name list of values to enter the name of the workbook or target 
segment you wish to use.

9. If you wish to create the list from multiple workbooks, target segments, or lists, 
then, in the Selection Criteria region, enter each source element on a separate 
line:

a. Using the Type drop-down list, select whether the source is a workbook or a 
target segment.

b. Use the Name list of values to enter the name of the source. 

c. Using the Action drop-down list, indicate how you wish the entries in the 
source to be used in combination with the other lists. You must always 
assign Include as the Action for the first source. 

The available actions for the other sources are:

* Include: Include all the customers or prospects in the list or workbook.
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* Exclude: Exclude all the customers or prospects in the list or workbook.

* Intersect: Use the intersection of two sources.

d. If you are using more than two sources, then use the Order fields to specify 
the order in which the application is to process the sources. The order you 
assign determines the outcome of the list generation process.

10. In Size Selection, enter information about the maximum size of the list you wish 
to generate either as an absolute number or as a percentage. Enter one of the 
two following:

� In the Maximum field, enter the maximum number of records for your list. 
List generation will stop after this number is reached.

� In the Percent of Rows field, enter a value for the percentage of candidates 
to be picked from among all those eligible. 

11. If you entered the maximum list size as a percentage in the previous step, then 
enter a weigh in the % field for each list source you added.

If you specify the first source to have a weight of 90%, for example, then 90% of 
the selections will be performed from that list. The percentages for your sources 
must add up to 100. 

12. If you have entered a maximum size for your list, then, in the Selection Size 
region, select one of the radio buttons corresponding to your desired selection 
method:

� Top Down: Starts picking from the top of the list until the maximum size is 
reached.

� Every Nth Row. Picks every Nth row, depending on the number you enter.

� Random: Selects entries at random. 

13. If you wish to have reports generated on list use, then, in the List Details region, 
select the Log Reports check box.

14. If you wish to remove duplicates at the time the list is generated, then, in the 
List Details region:

a. Select the Remove Duplicates on Generated List check box.

b. Select the rule used for the removal by clicking Go in the Rule field and 
using the list of values.

c. For each source you have added in the Selection Criteria region, enter a 
ranking in the Rank field. The rank you assign determines which source 
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will win in case there is a duplicate. The higher ranked source is the one 
that supplies the entry into your list. 

15. If you wish the duplicate removal process to use a list of words commonly used 
as duplicates, then select the Use Word Replacement check box. For example, a 
word replacement rule can instruct the application to treat Bill as a duplicate of 
William for first names. The word replacement rules are set up by your 
application administration team. 

16. If you are creating a list of Type Target, then, in the List Generation Region:

a. Select the Generate List check box.

b. If you with to generate this list immediately, then leave the Scheduled Date 
and Time Zone and Time fields blank. Otherwise fill in the desired day and 
time you wish the list to be generated.

17. Click Update to save the list details.

The List subtab appears.

If you have selected the Generate List check box and scheduled the list for 
immediate execution, then the list Status changes to Available when the list is 
generated.

Guidelines
The table below explains the different statuses for lists.

Field Explanation

Status List status can be set by the user and the 
application. Here are the values:

New Default status when you create 
a new list.

Locked The list is being used by a 
campaign. You cannot make 
any modifications.

Expired List is not available for use. 
Your license has expired or the 
list is out of date, for example.

Archived List is not available for use.
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References
� About List Types and Templates

� About Creating Lists

� About Workbooks, Worksheets, and Oracle Web Discoverer

Creating a List Import Mapping Template
Use this procedure to create an import mapping template. The template maps the 
fields of a list you wish to import. You must create this template before importing 
the list.

Prerequisites
None

Steps
1. Navigate to Audience > Import

2. Click Create.

The Import Mapping Template subtab appears.

If your list has a header row, then the Source Field displays the field name, 
otherwise this column displays the first record in the file.

3. Enter a template name.

4. Enter a code.

5. Leave the default destination column fields unless the destination fields cannot 
accommodate the size of the source field. You can view the field sizes in the 
Oracle Marketing Online Technical Reference Manual.

6. Optionally, update the Source Field Meaning. If the list has no header and you 
specified this during list creation, then the application uses a generic column 
reference, for example: COL1, COL2, and so on.

7. If you like to exclude any of the fields from the imported list, then unselect the 
Include check box next to that field.

8. Save your work by clicking Create.
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Viewing Existing Workbooks
Use this procedure to view existing workbooks in Oracle Web Discoverer. 

Prerequisites
None

Steps
1. In the Audience tab, click on an existing list name or click Create. 

The Create List or List Details subtab appears.

2. Click the Web Discoverer hyperlink at the top right hand corner of the window.

After the Oracle Web Discoverer applet finishes loading, Step 1 of the 
Workbook Wizard appears.

3. Click Open an existing workbook.

4. The question "Where is the workbook you want to open?" appears. 

5. Click Database. You can only access workbooks stored in the database.

6. Oracle Web Discoverer displays list of existing workbooks.

7. Select a workbook you wish to view.

8. Click Open.

Oracle Web Discoverer automatically executes the workbook query and 
displays the results. 

9. If you wish to view and edit the query, then click the Edit button on the toolbar.
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Oracle Web Discoverer displays the query. 

10. You can modify the workbook or worksheet using the same procedure outlined 
in Creating WorkBooks in Discoverer.

References
About List Types and Templates

About Creating Lists

About Workbooks, Worksheets, and Oracle Web Discoverer

Creating Workbooks in Oracle Web Discoverer
Oracle Web Discoverer allows you to create queries that you can use to generate 
lists in Oracle Marketing Online without the knowledge of programming or a query 
language. Use this procedure to create queries in Oracle Web Discoverer.

Prerequisites
None

Steps
1. In the Audience tab, click on an existing list name or click Create. 

The Create List subtab appears.

2. Click the Web Discoverer hyperlink at the top right hand corner of the window.
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After the Oracle Web Discoverer applet finishes loading, Step 1 of the 
Workbook Wizard appears.

3. Click Create a new workbook.

4. Select the Table radio button

5. Click Next to move to Step 2 of the wizard.

6. The wizard now displays all the Oracle Marketing Online folders. These hold 
the fields you can use to construct your query. 

7. To view the contents of a folder, click on the + node to the left of it.

8. Construct your query by moving whole folders or individual fields using the 
right arrow button:

a. Select the folder or field.

b. Click the right arrow button.

When you select a folder other folders and fields become grayed out (disabled). 
This means that the criteria in the grayed-out folders and fields are already 
included in the folder you have selected.

9. In the query you construct, you must include at least one mandatory field: 
Mandatory Identifier. If you have not included it in your query, then you can 
add it from the All Contacts folder.

10. If you are adding folders with mandatory fields in the form AMS <folder 
name> Id, then you must add these as well.

11. If you are building a query to create an email blitz, then include the following 
mandatory identifiers (see Guidelines for an example):

� Include Contact Details

� Include Organizational Details

� Include Email

12. If you plan to use a field for the condition of the query, then you must include 
that field in your query as well. For example, if you plan to restrict the query 

Note: You must include at least this mandatory field for a query to 
work properly.
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using the condition Organization Name = "Global Enterprises", then 
you must select the Organization Name field for your query. 

13. Click Finish.

Oracle Web Discoverer executes the query you just created and the results. 

14. If you wish to add a condition to the query, then:

a. Click the Edit button in the toolbar.

b. Select the Condition tab.

c. Click New.

The New Condition window appears.

d. In the Item field of the Formula region, select the item to be validated.

e. Using the Condition drop-down list, select the operator.

f. In the Values field, enter the value for the comparison.

g. Click OK.

The Conditions tab appears displaying the condition you have created.

h. Click OK.

15. Click Save on the toolbar. This is the diskette icon.

Guidelines
Here is a sample query you can use to create a workbook for an email blitz:

Select the following folders and fields to create a workbook that will extract email 
addresses for a mailing list which will be used in an direct email campaign

From the All Contacts folder select the following:

� Mandatory Identifier

� Include Contact Details

� Include Organization Details

� Include Email

� Organization Id

� Party Id

� Contact name (This field is optional.)
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� Contact phone (This field is optional.)

From the Contact Email folder, select the following fields:

� AMS Contact Email Id

� Contact Id

� Email Address

References
� About List Types and Templates

� About Creating Lists

� About Workbooks, Worksheets, and Oracle Web Discoverer

Importing a List
Use this procedure to import a list or modify an existing import.

Prerequisites
The list you are importing must be loaded as a text file in the directory specified by 
your application administrator using the system profile option AMS_IMP_CTL_
PATH.

Steps
1. Navigate to Audience > Import

2. If you wish to create a new list, then click Create.

The Import List subtab appears.

3. If you wish to modify an existing list import, then click on the name of the list 
you wish to edit.

The Import Details subtab appears.

4. Enter in the import list name.

5. Select the import type as Rented List. Other types are for future releases.

6. Specify other details of the imported list such as the version number, the vendor 
that supplied the list, the cost of purchasing the list, the expiration date, and a 
description.
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7. Enter the list import parameters:

a. Enter the file name for the import file.

b. Using the Mapping Template drop-down list, select an import mapping 
template you wish to use to map this file and indicate any number of rows 
to skip. If no mapping template exists, then click Create New to create it. 
(See Creating a List Import Mapping Template)

c. Specify how the columns are delimited in the import file and what the 
fields are enclosed with.

d. If a file header exists in the file, select the File Header Exists check box. The 
file header is the first row in the file which contains the field names of the 
imported file.

e. If you wish to have duplicate entries removed from the list, then select the 
De-Duplicate the Import check list.

f. Do not select Perform Post Import Processing. Post-import processing is not 
used in this release. All imported list entries are maintained separately from 
the parties (customer) tables. 

8. Click Create to execute the import into the database

9. You must now generate the list before it can be used. You can do so by creating 
a Workbook within Oracle Web Discoverer. 

Creating and Editing Target and Market Segments
Use this procedure to create target or market segments or edit existing ones. Target 
or market segments provide a way of organizing the queries you create in Oracle 
Web Discoverer. 

A market segment could be defined as all individuals earning over a certain income 
level in a Australia, for example. A target segment could be only those individuals 
living in the cities of Sydney and Melbourne.

Using the Parent Segment field, you can create hierarchies of market segments, 
called Target Groups, which you can track via Oracle Business Intelligence. Each 
segment you create has a one on one correspondence with a Oracle Web Discoverer 
workbook. You cannot create or modify the workbooks although you can view the 
existing SQL. 
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Prerequisites
You must create workbooks first.

Steps
1. Navigate to Audience > Segment

2. If you are creating a new segment, then click Create.

The Create Segment subtab appears.

3. If you wish to edit an existing segment, then select the segment name.

The Segment Details subtab appears displaying the segment setup.

4. Enter or modify the name for this target or market segment.

5. In Code, enter a unique identifier.

6. Select the type of segment as a target or market segment.

7. Use the parent segment to build a segment hierarchy. 

8. Enter a description for the segment.

9. Select a Oracle Web Discoverer workbook for the segment.

10. Click Update to save.

The SQL Viewer displays the SQL code used by the workbook.

Using the Message Tab
You can use the Message tab to:

� Remove a message from use

� View and edit a message

� Create a message

Removing a Message From Use
Use this procedure to remove a marketing message from use.

Prerequisites
None
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Steps
1. Navigate to the Message tab.

2. Deselect the Active check box next to the message you wish to remove from 
use.

3. Click Update.

The message can no longer be used to classify events and campaigns.

Viewing and Editing a Message
Use this procedure to view and edit a message.

Prerequisites
None

Steps
1. Navigate to the Message tab.

2. Select the hyperlink for the desired message. 

The Message Details subtab appears.

3. Edit the details as appropriate.

4. Click Update.

Creating a Message
Use this procedure to create a message to be used in classifying campaigns or 
events.

Prerequisites
None

Steps
1. Navigate to the Message tab.

2. Click Create. 

The Create Message subtab appears.

3. Enter the message name.
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4. In the Effective Dates field, enter the dates this message is to used.

5. Select the message type.

6. If you wish, you can change the message owner.

7. Enter a description of the message.

8. Click Create.

The Message Details subtab appears.

9. Fill in information in the different check-list items, called attributes. You can do 
so by clicking on their hyperlink. After you make an entry and return to this 
subtab, the attribute will have a check list next to it. All of the attributes are 
listed in the Guidelines section below. 

Guidelines:
The list below includes all check-list attributes used for messages. 

Only a subset of these attributes may be listed in the check list for the message you 
are entering. This is because different types of messages track different types of 
information. 

� Attachments 

� Metrics 

� Notes 

� Products

Using the Admin Tab
The Admin tab is where you set up features that include marketing activities, 
marketing mediums, and the custom setups which determine the checklist 
attributes that appear in campaigns and events. 

Some of the features of the Admin tab are available for marketing super users. You 
can use features of this tab to:

� Set up marketing mediums for campaigns

� Set up activity classifications

� Create custom setups for campaigns and events 

� Enable campaign and event approval workflow
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� Create venues for events

� Create an email blitz

In addition, application implementers and administrators can use features of this 
tab to:

� Set up the data fields to restrict the number of columns available for list 
generation

� Set up deduplication rules

� Create categories and subcategories

� Create a list of similar words used to identify duplicate records

� Mapping your customer model to Oracle Marketing Online

� Create metrics

Creating an EMail Blitz
Use this procedure to create an email blitz.

Prerequisites
You must use the seeded campaign custom setup of a Direct Marketing - Email. 

Steps
1. Create the email cover letter for mailmerge.

1. Create and execute a list of email recipients as described in Creating a List.

1. Create an execution campaign of campaign type Direct Marketing - Email 
according to the procedure found in Creating an Execution Campaign.

2.  Create a schedule.

3. In the Schedule details, enter the cover letter, the list you have created, and 
other details according to the procedure outlined in Entering Details for the 
Activity You Wish to Schedule. Make sure you select the Execute check box 
Click on Schedule. The email blitz is executed when you click Update in the 
Schedule Details subtab.
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Creating an Email Cover Letter for Mail Merge 
Use this general procedure to create an email cover letter that will be mail-merged 
and sent to your customers. 

Prerequisites
None

Steps
1. Create an HTML email cover letter using any HTML editor.

2. In the cover letter, insert the fields to be mail merged where you want the 
mailmerge text to appear. 

The fields must be surrounded by special double arrow bracket characters. For 
example: <<title>> <<first_name>> <<last_name>>. You can add 
these double brackets into the HTML source by adding &laquo; for the left 
bracket and &raquo; for the right bracket. For a list of available merge fields 
see Available Mailmerge Fields.

Here is what the HTML looks like for the salutation for the email:

Dear&laquo;title&raquo; &laquo;first_name&raquo; 
&laquo;last_name&raquo;

Here is a sample of what an email itself may look like with the mail merge 
fields circled:

Note: After you have selected and executed a list for a campaign 
schedule, the status of the list is updated from Available to 
Locked. You cannot reuse the same list again with that or any 
other campaign schedule. If you want to use same list entries 
again, then create the new list.

Note: These double arrow brackets are special characters. You 
cannot add them by typing in two left arrows and two right arrows 
on your keyboard.
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3. If the HTML cover letter you created contains images, then:

a. Create folder named Images and place the images in it.

b. Use the WinZip utility to zip up the HTML file and the Images folder with 
the images. You can ensure that the Image folder is preserved adding files 
using the Add Files with Wildcards Button.

 The resulting Zip file will look something like this:
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c. Name the Zip file in a way that will enable users to recognize the cover 
letter contents.

4. Navigate to Admin > Fulfillment > Master Document

5. Click Upload. 

The Master Document subtab appears.

6. Click Upload. 

The Upload Master Document subtab appears.

7. Click Browse.

8. Select the zip file you have prepared with the email cover letter contents.

9. Click Upload.

10. The Master Document subtab appears with the uploaded zip file listed in the 
Master Document Name column.

11. Using the Query drop-down list select source of the mail merge fields you are 
using. This can be one of the two seeded queries, the Marketing Simple Query 
or the Marketing Detailed Query, or a query developed by your implementation 
team.

12.  Click Update. 

Your cover letter is now ready for use in a marketing campaign.
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Searching 
Use this procedure to search the Oracle Marketing Online database for messages, 
campaigns, deliverables, events, and lists. 

Prerequisites
None

Steps
1. If you know at least a part of the name of the object you are looking for, then 

use Quick Find to search for it in the database. It is preferable to use Quick Find 
because this method of searching gives you a direct short cut to the object you 
are searching for. 

2. If you do not know at least the partial the name of the object or wish to search 
for the object using any number of criteria then: 

a. Use Advanced Search to find the object and note down its name.

b. Use Quick Find with the object name to open the object on your window.

Searching Using Quick Find
Use this procedure to search for campaigns, events, and other objects you can access 
in Oracle Marketing Online.

Prerequisites
None

Steps
1. If you know at least a part of the name of the object you are looking for, then 

use Quick Find to search for it in the database:

c. Select the type of object you are searching for from the Quick Find 
drop-down menu.

Note: Though you cannot search within Oracle Marketing Online 
for notes, attachments, tasks and other objects other than those 
listed above, you can find these by viewing the objects to which 
they are associated.
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d. Enter a partial or full name. You can use % to indicate omitted words or 
letters.

e. Click Go.

The Search Results window appears displaying the names of all of the 
found objects as hyperlinks. 

f. Click on the object name to display it.

Guidelines
For more information see Different Ways of Finding Information.

Using Advanced Search
Use this procedure to search for campaigns, events, deliverables or lists in Oracle 
Marketing Online using a number of search criteria. 

Prerequisites
None

Steps
1. Navigate to Advanced Search by clicking on the hyperlink to the right of the 

Quick Find field.

2. In the Object Types region, indicate what type of object you wish to search for 
by selecting the appropriate check box(es). You can make multiple selections.

3. If you wish to search by a partial object name, its status, source code, or owner 
then make entries in the Simple Query Criteria region fields. 

Note: You can speed up searches using the % wild card if you can 
supply the beginning or the end of a word or the sequence of 
words. For example, entering a search as %results is faster than a 
search for %results%. A search for Q1% is faster than a search for 
%Q1%.

Note: You cannot search for messages or tasks using Advanced 
Search.
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4. If you wish to search by the date an object is effective, then:

a. Estimate the dates by entering the general ledger periods in the Start Period 
and End Period fields. To enter the dates, click Go and use the list of values.

b. Enter more precise dates in the Dates From and Dates To fields.

5. If you wish to search by purpose, select the appropriate check boxes in the 
Purpose region.

6. If you wish to search by activity type and activity, then:

a. Select the appropriate activity type check box(es).

b. Select the desired activities in the Activity list box. You can select multiple 
activities by holding down the CTRL key on your keyboard.

7. If you wish to search by offer type, then select the appropriate check box(es) in 
the Offer Type region.

8. If you wish to search by audience segment, then select the segment(s) in the 
Segment list box. You can select multiple activities by holding down the CTRL 
key on your keyboard.

9. If you wish to search by geographical location, then click Add in the Geography 
region and use the list of values to add the location(s). 

10. If you wish to search by product or by product categories, then click Add in the 
Product region and select the product(s) or product categories from the list of 
values.

11. If you wish to search by deliverable, then click Add in the Deliverable region 
and select the deliverable(s) from the list of values.

12. If you wish to search by partner, then click Add in the Partner region and select 
the partner(s) from the list of values.

13. If you wish to search by message, then click Add in the Message region and 
select the message(s) from the list of values.

14. If you wish to search by workbook, then click Add in the Workbook region and 
select the workbook(s) from the list of values.

15. If you wish to search by list, then click Add in the Existing List region and select 
the list(s) from the list of values.

16. Click Search.

The Advanced Search Results window displays the results of your search. This 
list does not link to the objects themselves.
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17. If you wish to view an object, then use Quick Find to search for and display the 
object.

18. If you wish to view more details about an object, then follow the procedure 
outlined in Viewing Details About Advanced Search Results.

19. If the search does not return what you are looking for, or too many items are 
displayed, then conduct the search again.

Viewing Details About Advanced Search Results
Use this procedure to view the results of your Advanced Search in more detail.

 Prerequisites
You must perform an Advanced Search first.

Steps
1. If the search results list the object(s) you wish to view, then: 

a. Select the Select check box for each object you wish to view.

b. Click View Details.

A separate browser window lists information about the found items. 

2. If the search does not return what you are looking for, or too many items are 
displayed, then click on the Refine Search hyperlink and perform the Advanced 
Search again using different criteria.

Entering Geography Search Criteria
Use this procedure to enter one or more geography regions as search criteria in the 
Advanced Search.

Prerequisites
You must have Advanced Search open.

Steps
1. Navigate to the Geography Locator window. You can open it from the 

Geography region of Advanced Search by clicking Add.
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2. If you wish to restrict the selection of geographical locations to a particular 
geographical level, then: 

a. Make a selection from the Level drop-down list.   

b. Click Go to the right of the Name field.

The list of locations is restricted to the geographical level you selected.

3. If you wish to search for a geographical location, then:

a. In the Name field at the top of the window, enter a name or a partial name. 
You can use the% to substitute for missing letters.   

b. Click Go to the right of the Name field.

A list of found locations appears.

4. If you wish to add all geographical locations displayed in the window then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The locations are added to the list on the Advanced Search window.

c. If more then one page of locations displays, then click Next and repeat the 
same procedure.

5. If you wish to add only selected geographical locations, then:

a.  Select the check box next to each.

b. Click Add.

The locations are added to the list on the Advanced Search window.

c. If more than one page of locations displays, then click Next to view the next 
page and repeat this procedure.

Note: If more than one page of locations displays, you must add 
each page separately. The Select All button selects only those 
locations visible on a page at one time.

Note: If more than one page of locations displays, you must add 
locations on each page separately. A location you select on a page 
does not remain selected when you view another page.
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6. When you are done selecting geographical locations, click Close.

Entering Product Search Criteria
Use this procedure to enter one or more products or product families as search 
criteria in the advanced search.

Prerequisites
You must have Advanced Search open.

Steps
1. Navigate to the Product Locator window. You can open it from the Product 

region of Advanced Search by clicking Add.

2. Select whether you wish to add products or product families: 

a. From the Type drop-down, list select Product or Product Family.   

b. Click Go to the right of the Name field.

The window displays the list of products or product families depending on 
your selection.

3. If you wish to search for a products or product families, then:

a. In the Name field at the top of the window, enter a name or a partial name. 
You can use the% character to substitute for missing letters.   

b. Click Go to the right of the Name field.

The window displays the list of products or product families.

4. If you wish to add all products or product families displayed in the window 
then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The products or product families are added to the list on the Advanced 
Search window.

c. If more then one page of product or product families displays, then click 
Next and repeat the same procedure.
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5. If you wish to add only selected products or product families, then:

a.  Select the check box next to each.

b. Click Add.

The products or product families are added to the list on the Advanced 
Search window.

c. If more than one page of locations displays, then click Next to view the next 
page and repeat this procedure.

6. When you are done, click Close.

Entering Deliverable Search Criteria
Use this procedure to enter one or more deliverables as search criteria in the 
advanced search.

Prerequisites
You must have Advanced Search open.

Steps
1. Navigate to the Deliverable Locator window. You can open it from the 

Deliverable region of Advanced Search by clicking Add.

2. Select whether you wish to search for a deliverable, then: 

a. Enter its name or a partial name into the Name field. You can use the % to 
substitute for missing letters. 

b. Click Go.

Note: If more than one page of product families displays, you 
must add each page separately. The Select All button selects only 
those products or product families visible on a page at one time.

Note: If more than one page of products or product families 
displays, you must add locations on each page separately. A 
product or product family you select on a page does not remain 
selected when you view another page.
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The window displays the list of found deliverables.

3. If you wish to add all deliverables displayed in the window as search criteria, 
then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The deliverables are added to the list on the Advanced Search window.

c. If more then one page of deliverables displays, then click Next and repeat 
the same procedure.

4. If you wish to add only selected deliverables, then:

a.  Select the check box next to each.

b. Click Add.

The deliverables are added to the list on the Advanced Search window.

c. If more than one page of deliverables displays, then click Next to view the 
next page and repeat this procedure.

5. When you are done, click Close.

Entering Partner Search Criteria
Use this procedure to enter one or more partners as search criteria in the advanced 
search.

Prerequisites
You must have Advanced Search open.

Note: If more than one page of deliverables displays, you must 
add each page separately. The Select All button selects only those 
deliverables visible on a page at one time.

Note: If more than one page of deliverables displays, you must 
add locations on each page separately. A deliverable you select on a 
page does not remain selected when you view another page.
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Steps
1. Navigate to the Partner Locator window. You can open it from the Partner 

region of Advanced Search by clicking Add.

2. Select whether you wish to search for a partner, then: 

a. Enter its name or a partial name into the Name field. You can use the % to 
substitute for missing letters. 

b. Click Go.

The window displays the list of found partners.

3. If you wish to add all partners displayed in the window as search criteria, then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The partners are added to the list on the Advanced Search window.

c. If more then one page of partners displays, then click Next and repeat the 
same procedure.

4. If you wish to add only selected partners, then:

a.  Select the check box next to each.

b. Click Add.

The partners are added to the list on the Advanced Search window.

c. If more than one page of partners displays, then click Next to view the next 
page and repeat this procedure.

5. When you are done, click Close.

Note: If more than one page of partners displays, you must add 
each page separately. The Select All button selects only those 
partners visible on a page at one time.

Note: If more than one page of partners displays, you must add 
locations on each page separately. A partner you select on a page 
does not remain selected when you view another page.
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Entering Message Search Criteria 
Use this procedure to enter one or more messages as search criteria in the advanced 
search.

Prerequisites
You must have Advanced Search open.

Steps
1. Navigate to the Message Locator window. You can open it from the Message 

region of Advanced Search by clicking Add.

2. Select whether you wish to search for a message, then: 

a. Enter its name or a partial name into the Name field. You can use the % to 
substitute for missing letters. 

b. Click Go.

The window displays the list of found messages.

3. If you wish to add all messages displayed in the window as search criteria, 
then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The messages are added to the list on the Advanced Search window.

c. If more then one page of messages displays, then click Next and repeat the 
same procedure.

4. If you wish to add only selected messages, then:

a.  Select the check box next to each.

b. Click Add.

The messages are added to the list on the Advanced Search window.

Note: If more than one page of messages displays, you must add 
each page separately. The Select All button selects only those 
messages visible on a page at one time.
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c. If more than one page of messages displays, then click Next to view the 
next page and repeat this procedure.

5. When you are done, click Close.

Entering Workbook Search Criteria
Use this procedure to enter one or more workbooks as search criteria in the 
advanced search.

Prerequisites
You must have Advanced Search open.

Steps
1. Navigate to the Workbook Locator window. You can open it from the Workbook 

region of Advanced Search by clicking Add.

2. Select whether you wish to search for a workbook, then: 

a. Enter its name or a partial name into the Name field. You can use the % to 
substitute for missing letters. 

b. Click Go.

The window displays the list of found workbooks.

3. If you wish to add all workbooks displayed in the window as search criteria, 
then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The workbooks are added to the list on the Advanced Search window.

c. If more then one page of workbooks displays, then click Next and repeat 
the same procedure.

Note: If more than one page of messages displays, you must add 
locations on each page separately. A message you select on a page 
does not remain selected when you view another page.
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4. If you wish to add only selected workbooks, then:

a.  Select the check box next to each.

b. Click Add.

The workbooks are added to the list on the Advanced Search window.

c. If more than one page of workbooks displays, then click Next to view the 
next page and repeat this procedure.

5. When you are done, click Close.

Entering List Search Criteria
Use this procedure to enter one or more lists as search criteria in the advanced 
search.

Prerequisites
You must have Advanced Search open.

Steps
1. Navigate to the List Locator window. You can open it from the List region of 

Advanced Search by clicking Add.

2. Select whether you wish to search for a list, then: 

a. Enter its name or a partial name into the Name field. You can use the % to 
substitute for missing letters. 

b. Click Go.

The window displays the list of found lists.

Note: If more than one page of workbooks displays, you must add 
each page separately. The Select All button selects only those 
workbooks visible on a page at one time.

Note: If more than one page of workbooks displays, you must add 
locations on each page separately. A workbook you select on a page 
does not remain selected when you view another page.
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3. If you wish to add all lists displayed in the window as search criteria, then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The lists are added to the list on the Advanced Search window.

c. If more then one page of lists displays, then click Next and repeat the same 
procedure.

4. If you wish to add only selected lists, then:

a.  Select the check box next to each.

b. Click Add.

The lists are added to the list on the Advanced Search window.

c. If more than one page of lists displays, then click Next to view the next 
page and repeat this procedure.

5. When you are done, click Close.

Using the List of Values                       
This topic explains how to use list of values (LOV) fields in the application. These 
are fields with a Go button to the right. 

Prerequisites
None

Steps
1. If you know at least part of the string of characters you are searching for:

Note: If more than one page of lists displays, you must add each 
page separately. The Select All button selects only those lists visible 
on a page at one time.

Note: If more than one page of lists displays, you must add 
locations on each page separately. A list you select on a page does 
not remain selected when you view another page.
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a. Enter the characters you wish to search for in the field. 

You can use the percent symbol to substitute for any characters. For 
example, entering jo% searches for all of the objects starting with the letters 
jo. Entering %jo, searches for all of the objects ending with the letters jo. 
Searching for j%o searches for any string of characters beginning with j 
and ending with o.

b. Click Go.

The list of values window opens, displaying the results of your search.

2. If the search returns multiple pages of results, then use the First, Previous, Next, 
and Last buttons to navigate through the results.

3. If you wish to repeat your search with modified search criteria, then:

a. Enter the new search string in the Search Keyword field.

b. Click Search.

4. To select and enter a value from the list into the field, click on the value which 
appears as a hyperlink.

5. If you do not wish to make an entry, then click Cancel.

Troubleshooting

System Error: You have been signed out automatically.
If you receive this error:

1. Clear the cache of your browser following instructions that come with your 
browser.

2. Close all browser windows. If you are using Netscape, this includes all your 
email messages.

3. Restart the browser.

4. Log into Oracle Marketing Online.

Note: You can speed up searches using the % wild card if you can 
supply the beginning or the end of a sequence of characters. For 
example, searching for %results is faster than a searching for 
%results%. A search for Q1% is faster than a search for %Q1%.
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Implementing Oracle Marketing Online

The implementation group of topics explain how to set up and customize Oracle 
Marketing Online.

You can customize Oracle Marketing Online are by setting up system profile 
options, which control the overall behavior of the product, and by setting up lists of 
values (LOVs) and drop-down lists for individual fields within the product. 

The choices users see in the LOVs and drop-down lists come from two sources:

� Lookups you set while logged in to the Oracle Forms interface under the Oracle 
Marketing Administrator responsibility.

� Setups you perform in the Admin tab of Oracle Marketing Online.

For this reason, you must log into both Oracle Applications under the Oracle 
Marketing Administrator responsibility (this is the Forms-based interface) and the 
Oracle Marketing Online application (HTML interface).

Major Implementation Steps
Below are the major steps to complete an Oracle Marketing Online implementation. 
Use this procedure to plan out your implementation. Each step indicates whether it 
is required or not. Follow links to more detailed procedures. 

Prerequisites
Complete installation of the CRM suite as described in:

� Oracle System Administrator’s Guide (A75396-01), Implementation Appendix

� Implementing CRM Applications Release 11i (A85301-01), Marketing Applications

Steps
1. Set up an implementation user. (Required)

2. If you are implementing a new installation of Oracle Marketing Online in an 
environment where Oracle ERP applications are not implemented, then you 
must set up basic ERP functions before implementing the application itself. 
(Required)
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3. Log into Oracle Applications under the Oracle Marketing Administrator 
responsibility (this is the Forms-based interface). (Required)

4. Log into the Oracle Marketing Online application (this is an HTML interface 
accessed through your browser). (Required)

Throughout the implementation you will be switching between the 
Forms-based Oracle Marketing Administration application, which you use to 
set up system profiles and lookups and the HTML-based Oracle Marketing 
Online application itself, where most of the setup is done in the Admin tab.

5. Set up CRM foundation modules. (Required)

6. Create Oracle Marketing Online users. These users are the owners of different 
objects in the application. Objects include events, collateral, and campaigns.

7. Set Oracle Marketing Online lookups. (Required)

8. Set up status classifications. These are the drop-down lists that can be used to 
classify most Oracle Marketing Online objects, including campaigns, events, 
and deliverables. (Required)

9. Create category and subcategory classifications for campaigns, deliverables, 
events, budgets, metrics, and costs. (Optional)

10. Enable the budget tab. (Required)

11. Set up the campaign tab. (Required)

12. Set up metrics and costs for your campaigns and events. (Required)

13. Create venues for your events. (Required)

14. Set up the data fields to restrict the number of columns available for list 
generation. (Optional)

15. Set up deduplication rules. (Required)

16. Set up word replacement rules. These are lists of similar words used to identify 
duplicate records in lists. (Required)

17. Set up geographical regions. (Optional)

18. Map your customer model. This step requires consulting help. (Optional)

19. Set up system profile options. (Required)

20. Implement Oracle Web Discoverer. (Required)

21. Set up news and stock quotes for user’s home pages. (Optional)
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Setting Up the Implementation User
Use this procedure to set yourself up as a user for the implementation.

Prerequisites
None

Steps
1. Log in as Sysadmin.

2. Navigate to Security > User >Define.

3. Create a user. (For example: <IMPLEMENT>)

4. Assign the following responsibilities to the user: 

� General Ledger Super User 

� US HRMS Manager 

� Inventory 

� CRM Administration 

� Oracle Marketing Administration 

� Oracle Marketing Super User (Self Service) 

� Preferences (Self Service) 

� System Administrator

5. Log out and log in as <IMPLEMENT>. 

6. Change your password. 

Setting Up ERP Applications for New Installations
Use this procedure to set up ERP applications for use with Oracle Marketing Online 
in new installations. This procedure covers only steps required to make ERP 
applications work with Oracle Marketing Online, not the steps required to 
implement those applications.

Steps
1. Set up Oracle General Ledger. (Required)

2. Set up Oracle Human Resources. (Required)
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3. Set up Oracle Inventory. (Required)

4. Set up Advanced Pricing following the instructions specified in Oracle Pricing 
User’s Guide (A77032-01). (Required)

Implementing Oracle General Ledger

Prerequisites
Knowledge of setting up Key Flexfields is a must. 

Steps
1. Log in as the <IMPLEMENT> user. 

2. Choose the General Ledger responsibility.

3. Set up accounting calendar types (Setup > Financials > Calendars > Types). 

4. Set up the accounting calendar (Setup > Financials > Calendar >Accounting) 

5. Set up currencies (Setup > Currencies > Define) that are needed for your 
implementation.

6. Set up exchange rates. (Setup > Currencies > Rates > Daily)

7. Set up accounting flexfields (Setup > Financials > Flexfields > Key > 
Segments). 

Make sure the concurrent process for flexfield compilation is complete before 
proceeding further. 

8. Define a set of books (Setup > Financial > Books > Define).

9. Use SqlPlus to check your Set of Books (SOB) under table GL_SETS_OF_
BOOKS

Implementing Oracle Human Resources

Prerequisites
You must complete your implementation of Oracle General Ledger.

Steps
1. Switch Responsibility to US HRMS Manager.
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2. Define Org Types (Other Definitions > Lookup Tables). Org Types can be 
Business Group, Department, HQ, or any other types suited to your business 
needs. 

3. Define locations (Work Structures > Location). These are used to set up 
organizations in the next step.

4. Define organizations (Work Structures > Organization > Description). In the 
Organization Classifications region, assign business groups. 

5. Use SqlPlus to check your work and make a note of your ORGANIZATION_ID 
and BUSINESS_GROUP_ID from table HR_ALL_ORGANIZATION_UNITS.

6. Switch responsibility to System Administrator.

7. Set the site level value for profile option HR: Business Group to one of the new 
business groups defined above. 

8. Set the responsibility-level (US HRMS Manager) value for profile option HR: 
Business Group to one of the new business groups defined above. 

9. Set the site-level value for profile option HR: Security Profile to one of the new 
business groups defined above. 

10. Set the responsibility-level (US HRMS Manager) value for profile option HR: 
Security Profile to one of the new business groups defined above. 

11. Switch responsibility to US HRMS Manager.

12. Define Legal Entity (Workstructure > Organization >Description): 

a. Associate the GRE/Legal Entity classification with your organization and 
continue with additional setups as needed. 

b. Enter the set of books. 

13. Double check your work:

a.  Under Help > Diagnostics, examine for block HOU1 and field BUSINESS_
GROUP_ID.

b. Verify the value of BUSINESS_GROUP_ID for block $PROFILES$ and field 
PER_BUSINESS_GROUP_ID,

Note:  A single Organization can act as a business group, a legal 
entity and an operating unit. Please be very clear before starting 
this setup.
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c.  Verify the value of BUSINESS_GROUP_ID. 

14. Define your operating unit (Workstructure > Organization >Description) 

a. Associate the Operating Unit classification with your organization and 
continue with additional setups needed. 

b. Enter the legal entity. 

c. Switch to the Sysadmin responsibility.

d. Change the site level profile option for MO: Operating Unit to the operating 
unit you defined.

15. Switch to the HR responsibility.

16. Define the HR Organization (Workstructure > Organization > Description) 

a. Associate the HR Organization classification with your organization. 

17. Define Inventory Organization (Workstructure > Organization > Description) 

a. Associate the Inventory Organization classification.

b. Click Others. 

c. In Accounting Information, enter the legal entity, the set of books, and the 
operating unit created earlier. 

d. Use SqlPlus to double-check data in tables HR_ALL_ORGANIZATION_
UNITS, HR_ORGANIZATION_INFORMATION, HR_LEGAL_ENTITIES, 
and HR_OPERATING_UNITS.

18. If you wish to enable multi-organizational features for new installations, then 
run the Adadmin concurrent program to enable Multi-Org at site level. 
Adadmin will pick the MO: Operating Unit profile value set at the site level. 

19. If you are implementing a new installation you must create employees:

a. Define the employee. (People > Enter and Maintain)

b. Define the manager of the employee by clicking Assignment. This step also 
assigns the employee to an organization. The manager’s organization must 
be one of an HR business groups you have defined previously. 
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20. Set up a Business Unit: 

a. Navigate to US HR MANAGER->Other Definitions->Look Up Tables. 

b. In the Look Up Tables form, search for and set up values for ORG_TYPE.

c. In the CODE field for ORG_TYPE, enter the value BU (This is the key). 

d. In the meaning field enter the value Business Unit and a free-form 
description. 

e. As an option, you may also define Company with the code COMP and 
Department with the code DEPT.

f. After you have defined your ORG_TYPE, you must describe your ORG_
TYPE. This is done by navigating to US HR MANAGER->Work 
Structures->Org.-> Description. 

g. Once you have opened the Description form, select the New tab. 

h. In the Name field, enter the business unit name. For example, Business 
Computer Organization. 

i. Using the Type list of values, select the Business Unit that you defined 
previously. 

j. Enter an address.

k. Save the record. 

Implementing Inventory
You must implement Oracle Inventory using this procedure if you wish to make 
marketing deliverables and events available through other CRM applications, 
including Oracle iStore and Oracle TeleSales.

Only the steps listed here are required to set up Oracle Marketing Online for use 
with Oracle Inventory. For more details on how to carry out these steps, please see 
Oracle Inventory User’s Guide (A83505–01). 

Note:  You must enter the manager for an employee for Oracle 
Marketing Online Workflow approval to work correctly. If you are 
creating a new business group instead of using the seeded business 
group, and if you receive the flexfield error (Code = GRP), then you 
must set up the People Group flexfield.
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Prerequisites
You must complete your implementation of Oracle General Ledger.

Steps
1. Switch Responsibility to Inventory. 

2. Define the Item Flexfield (Setup > Flexfields > Key > Segments).

3. Make sure you compile each flexfield before preceding to the next step.

4. Define the Item Categories flexfield (Setup > Flexfields > Key > Segments). 

5. Define the Item Catalog Group flexfield (Setup > Flexfields > Key > 
Segments). 

6. Define the Stock Locator flexfield (Setup > Flexfields > Key > Segments).

7. Define Sales Orders flexfield (Setup > Flexfields > Key > Segments).

8. Define locations (Setup > Organization > Location).

9. Define the organization calendar (Setup > Organization > Calendar). 

10. Switch responsibility to System Administrator. 

11. Set the value at the responsibility level for Profile Option (HR:User Type) to HR 
User. 

12. Switch responsibility to Inventory.

13. Define the inventory organization (Setup > Organization > Organization).

14. Define the organization parameters (Setup > Organization > Organization 
Parameter). You can do this by clicking Others in the previous step).

15. Change the organization (Setup > Change Organization).

16. Define Unit of Measure Classes (Setup > Unit of Measure > Classes). 

17. Define the Unit of Measure (Setup > Unit of Measure > Unit of Measure). 

18. Define Unit of Measure conversions (Setup > Unit of Measure > Conversions).

19. Define category codes (Setup > Items > Categories > Category Codes).

20. Define category sets (Setup > Items > Categories > Category Sets). 

21. Define default category sets (Setup > Items > Categories > Default Category 
Sets).

22. Log in as a System Administrator.
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23. Set the following system profile options at the application level:

�       INV: Default Primary Unit of Measure

�       INV: Accounting Category Set

�       INV: Item Master Flexfield

�       INV: Product Family Item Template Name

24. Log in under the Marketing Administrator responsibility.

25. Set the following system profile options at the site level:

� AMS: Item Validation Master Organization

� AMS: Pricelist Header Name for Events. 

� AMS: Should Call to Inventory Module. Set to Y.

� AMS: Should Call to Pricing Module. Set to Y. 

Setting Up CRM Foundation Modules
1. You must set up the following modules in CRM Foundation:

� Resource manager types: You must set up people and venues.

� Resource manager roles: These are used in execution events for the Resource 
check-list attribute.

� Note types: These are used in the Notes check-list attribute in the field Note 
Types.

� Source to Note-Type Mapping: This determines which notes show up in the 
Note check-list attribute under campaigns, events, deliverables, messages, and 
all of the other Oracle Marketing Online objects.

� Task types: These appear in the Task Type drop-down list. 

� Task status: The values you add here determine what appears in the Status 
drop-down list for tasks.

� Task priority: This determines the values that appear in the Priority drop-down 
list for tasks.

2. Import geographic hierarchies (Required):

a. Log into Oracle Applications under the CRM Administration responsiblity.

b. Run the concurrent program Load Geographic Hierarchies.
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Guidelines
Refer to the corresponding topic in CRM Foundation Implementation Guide 
(A86122-01). You can find relevant information in these topics:

Creating Oracle Marketing Online Users
Use this procedure to create users for Oracle Marketing Online. These are referred 
to in the application as owners. The procedure for creating users requires two 
additional steps beyond the usual procedure of setting up users in the Oracle 
Human Resources application

Prerequisites
None

Steps
1. Log on as the implementer.

2. Choose the responsibility: Human Resources.

3. Create an employee.

a. Navigate to People > Enter and Maintain.

b. Make sure Person Type is Employee. 

c. Enter all other required fields.

4. Switch to the System Administrator responsibility.

5. Create Oracle Marketing Online users:

a. Create a user. 

Information Sources for CRM Setups

CRM Foundation Module CRM Foundation Concepts Topic

Resource Manager Roles Understanding Resource Manager

Implementing Resource Manager

Note Types Implementing Notes 

Task Type

Task Status

Task Priority

Implementing Task Manager
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b. Assign Oracle Marketing Super User as the responsibility. 

c. Assign the newly created person in the Person field.

d. Open the System Profile Values window.

e.  Set up the following Profile options for the user:

*  ICX_LANGUAGE. Must be set to your language, for example, 
American English. 

*  JTF_PROFILE_DEFAULT_APPLICATION: Enter "530". This takes users 
directly to Oracle Marketing Online when they sign on. 

*  JTF_PROFILE_DEFAULT_RESPONSIBILITY: Enter "21706" 

6. Import the employee as a resource:

a. Switch to the CRM Administrator responsibility.

b. Navigate to Maintain Resource > Import Resources. 

c. In the Name field, enter the employee you have created.

d. Click Search. 

e. Click Create Resource. 

f. Click OK.

g. Click Save Resources. 

h. Click Details to verify the User ID you created.

Setting Up Oracle Marketing Online Lookups
Oracle Marketing Online includes lookups with three different levels of 
modification:

Note: The DEFAULT_APPLICATION and DEFAULT_
RESPONSIBILITY values are important because they determine the 
menu structure that is displayed when the user logs in. If you want 
your application menus to launch when the user logs in, then you 
must set the default application to your appID and default 
responsibility to the respID that maps to the menu structure.
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� System: The implementer can only change the wording of a list of value (LOV) 
choices the user sees on the screen. No deletions or additions are allowed.

� Extensible: The implementer can change both the wording of the LOV choices 
and add new choices for the user.

� User: The implementer can change the lookup completely, deleting and adding 
LOV choices at will.

The lookup table in this section lists the three different types of lookups 
alphabetically. Included are their seeded values, navigation paths, and the names of 
the fields they affect.

About Navigation Paths in the Lookup Table
The navigation paths are included to give you an idea what areas of the application 
are affected by each lookup. Some lookups may affect a field that is found in 
multiple tabs. Not all of these are covered. Other lookups affect check-list attributes 
for campaigns and events and require you to navigate through a campaign or event 
you have created. You may not be able to navigate to that attribute through every 
campaign or event because which attributes appear depends on the way you 
implement custom setups.

Here is how to read the navigation paths in this table:

� Campaign > any campaign > Schedule

Navigate to the Campaign tab, drill down on any campaign, select the Schedule 
check-list attribute.

� Event > Execution Event > any execution event > Registration

Navigate to the Event tab, select the Execution Event subtab, drill down on any 
execution event, and select the Registration check-list attribute.

� Campaign > Rollup or Execution Campaign > any campaign > Offers > lump-sum 
offer

Navigate to the Campaign tab, select either the Rollup Campaign or Execution 
Campaign subtab, drill down on any campaign that has a Offers attribute, select 
the Offers attribute, and create a lump-sum offer or examine the details of an 
existing one.
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Oracle Marketing Online Lookups 

Lookup Type Code Meaning Affected areas Field 
Access 
Level

AMS_ACCESS_TYPE GROUP Team Campaign > any 
campaign > Team

User/Role System

USER User

AMS_APPROVAL_TYPE BOTH Theme and Budget 
Approval

Admin > Custom 
Setup

Enables one or 
both of the 
following 
fields: Theme 
Approval, 
Budget 
Approval

System

BUDGET Budget

THEME Theme

AMS_ATTACHMENT_
TYPE

FILE

URL

File Attachment 
check-list attribute 
used in all tabs. 

 Type

(Classification 
for 
attachments)

Extensible

URL

AMS_BUDGET_
APPROVAL

APPROVED Approved Budget > any 
budget

Status

(of budget)

User

CLOSED Accounting Closed

NEW Planning

PENDING Pending Approval

REJECTED Rejected by Approver

AMS_BUDGET_TRANS_
TYPE

CREDIT Credit Budget > any 
budget

Specifies 
whether 
posting to 
General 
Ledger is a 
credit or a 
debit.

User

DEBIT Debit

AMS_CAMPAIGN_
PURPOSE

AWARENESS Awareness Campaign > any 
campaign > Purpose

 Purpose Extensible

LEAD Lead Generation

LEAD_
MATURATION

Lead Maturation

SALES_
READINESS

Sales Readiness

AMS_CAMPAIGN_
SCHEDULE_STATUS

ACTIVE Active Campaign > any 
campaign > 
Schedule

 Status System

ARCHIVED Archived

BOOKED Booked

CANCELLED Cancelled

COMPLETED Completed

NEW New
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AMS_CAMPAIGN_STATUS ACTIVE Active Campaign > any 
campaign 

Status System

ARCHIVED Archived

AVAILABLE Available

CANCELLED Cancelled

COMPLETED Completed

DENIED_BA Denied - Budget 
Approval

DENIED_TA Denied - Theme 
Approval

NEW New

ON_HOLD On-hold

PLANNING Planning

SUBMITTED_BA Submitted - Budget 
Approval

SUBMITTED_TA Submitted - Theme 
Approval

AMS_CHANNEL_RATING BAD Bad Admin > General > 
Marketing Medium

 Rating Extensible

EXCELLENT Excellent

GOOD Good

MODERATE Moderate

VGOOD Very Good

AMS_CHANNEL_TYPE EXTERNAL External Admin > General > 
Marketing Medium

 Type System

INTERNAL Internal

AMS_DELIV_STATUS ARCHIVED Archived Campaign > any 
campaign > 
Deliverable> any 
deliverable

 Status 
(deliverable)

System

AVAILABLE Available

CANCELLED Cancelled

DENIED_BA Denied - Budget 
Approval

NEW New

SUBMITTED_BA Submitted - Budget 
Approval

SUPERCEDED Superseded

Oracle Marketing Online Lookups 

Lookup Type Code Meaning Affected areas Field 
Access 
Level
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AMS_DELIVERY_MEDIA_
TYPE

ISEMINAR iSeminar Event > Execution 
Event > any 
execution event

Delivery 
Method

Extensible

ON_SITE On Site

WEB Web

AMS_EVENT_AGENDA_
STATUS

CONFIRMED Confirmed Event > Execution 
Event > any 
execution event > 
Agenda

 Status (event 
agenda)

System

UNCONFIRMED Unconfirmed

AMS_EVENT_
ATTENDANCE_FAILURE

AGENDA_
CHANGE

Agenda Change Event > Execution 
Event > any 
execution event > 
Registration > 
View Reason

(View Reason is a 
hyperlink on the 
Registration 
attribute)

Reason Extensible

DISASTER Natural Disaster

PERSONAL_
EMERGENCY

Personal Emergency

SCHEDULE_
CONFLICT

Schedule Conflict

SPEAKER_
CHANGE

Speaker Change

VENUE_
CHANGE

Venue Change

WORK_
EMERGENCY

Work Emergency

AMS_EVENT_CERT_
CREDIT_TYPE

GENERAL General Event > Execution 
Event > any 
execution event > 
Registration

Credit Type User

AMS_EVENT_DAY FIVE 5 Event > any rollup 
or executive event > 
Event Agenda

Day System

FOUR 4

ONE 1

THREE 3

TWO 2

AMS_EVENT_PAYMENT_
STATUS

COMP Complimentary Event > Execution 
Event > any 
execution event > 
Registration

Marketing 
Event Payment 
Status

System

FREE Free

INVOICED Invoiced

PAID Paid

REFUNDED Refunded

Oracle Marketing Online Lookups 
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AMS_EVENT_REG_
STATUS

CANCELLED Cancelled Event > Execution 
Event > any 
execution event > 
Registration

Status (event 
registration)

System

ENROLLED Enrolled

REGISTERED Registered

TARGETED Targeted

WAITLISTED Wait-listed

AMS_EVENT_RESOURCE_
TYPE

AMS_PEOPLE People Event > Execution 
or Rollup Event > 
any event > 
Resources

 Type System

AMS_VENUES Venues

AMS_EVENT_SPEAKER_
STATUS

BOOKED Booked Event > Execution 
Event > any 
execution event > 
Event Agenda

 Status

(speaker)

System

CANCELLED Cancelled

CONFIRMED Confirmed

SCHEDULED Scheduled

AMS_EVENT_STATUS ACTIVE Active Event Marketing 
Event Status

System

ARCHIVED Archived

AVAILABLE Available

CANCELLED Cancelled

CLOSED Closed

DENIED_BA Denied Budget 
Approval

DENIED_TA Denied Theme 
Approval

NEW New

ON_HOLD On Hold

PLANNING Planning

SUBMITTED_BA Submitted Budget 
Approval

SUBMITTED_TA Submitted Theme 
Approval

AMS_EVENT_STREAM_
TYPE

A A Event > Rollup or 
Execution Event > 
any event > Event 
Agenda

Track Extensible

B B

C C

D D
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AMS_EVENT_TYPE BRIEFING Briefing Event  Type System

CONFERENCE Conference

EXHIBITION Exhibition

HOSPITALITY Hospitality

INTERNAL_
EVENT

Internal Event

LAUNCH Launch

SEMINAR Seminar

SPEAKING_
ENGAGEMENT

Speaking 
Engagement

SPONSORSHIP_
EVENT

Sponsorship

TRADE_SHOW Trade Show

WEB_SEMINAR Web Seminar

WORKSHOP Workshop

AMS_EVENT_WAITLIST_
ACTION

FIRST_COME_
FIRST

First Come First Event > Execution 
Event > any 
execution event > 
Registration

Rule

(for wait list)

System

AMS_FCAST_BASE_UOL_
SOURCE

For N-tier 
marketing 
applications only. 
Affects budgets 
and claims.

AMS_FCAST_PERIOD_
VIEW

For N-tier 
marketing 
applications only. 
Affects budgets 
and claims.

AMS_FCAST_UOM CS CS For N-tier 
marketing 
applications only. 
Affects budgets 
and claims.

Extensible

EA EA

USD USD

AMS_FND_ALLOC_
ALLOC_BASIS

EVEN Even distribution Budget > 
Allocation’

The method of 
fund allocation to 
budgets

Extensible

Oracle Marketing Online Lookups 
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AMS_FND_ALLOC_UOM USD USD Unit of measure for 
fund allocations

Extensible

AMS_FORMULA_TYPE ALLOCATION Allocation For N-tier 
marketing 
applications only. 
Affects budgets 
and claims.

Extensible

HOLDBACK Hold Back

AMS_FUND_SOURCE CAMP Campaign Campaign > any 
campaign > Budget

Type System

EVEH Rollup Event

EVEO Execution Event

FUND Budget

AMS_IMPORT_STATUS ARCHIVED Archived Audience>Import  Status System

AVAILABLE Available

NEW New

PROCESSED Processed

PROCESSED-INC
OMPLETE

Processed - 
Incomplete

AMS_IMPORT_TYPE EVENT Event Audience > Import 
> any list

Type System

LEAD Lead

RESPONSE Response

SOURCE Rented List

AMS_IMP_DELIMITER_
TYPE

"Double Quotation Audience > Import 
> Create

Field Enclosed 
by

System

’Single Quotation

, Comma

; Semi-colon

FIXED Fixed Length

SPACE Space

TAB Tab

AMS_LIST_ROW_SELECT_
TYPE

NTH_RECORD Nth Record Audience > 
Audience > any list

Selection Size System

RANDOM Random

STANDARD Standard

AMS_LIST_SEARCH A All lists Audience > 
Audience

View System

U My lists
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AMS_LIST_SELECT_
ACTION

EXCLUDE Exclude Audience > 
Audience > any list

Selection criteria 
for Action fields

Action System

INCLUDE Include

INTERSECT Intersect

AMS_LIST_SELECT_TYPE CELL Target Segment Audience > 
Audience > any list

Type System

DIWB WorkBook

LIST Existing List

AMS_LIST_STATUS ARCHIVED Archived Audience > 
Audience > any list

 Status System

AVAILABLE Available

LOCKED Locked

NEW New

PENDING Pending

RESERVED Reserved

AMS_LIST_TYPE TARGET Target Audience > 
Audience > any list

Type System

TEMPLATE Template

AMS_MARKET_ELIG_
TYPE

GEO_AREA Geographic Area Budget > any 
budget > Allocation

N-tier 
marketing use 
only

System

MARKET_
SEGEMENT

Market Segment

TERRITORY Territory

AMS_MEDIA_TYPE BROADCAST Advertising Admin > Activity

(affects all Activity 
Type fields in 
campaigns)

Activity Type System

DEAL Deal

DIRECT_
MARKETING

Direct Marketing

EVENTS Events

INTERNET iMarketing

IN_STORE In-store

PUBLIC_
RELATIONS

Press and Analyst 
Relations

TRADE_
PROMOTION

Trade Promotion

AMS_MESSAGE_TYPE BRAND Product Family Message Type Extensible

PRODUCT Product

VISION Vision

Oracle Marketing Online Lookups 
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AMS_METRIC_ACCRUAL_
TYPE

FIXED Fixed For internal system 
use only. Does not 
affect UI

System

VARIABLE Variable

AMS_METRIC_VALUE_
TYPE

N Numeric Admin > General > 
Metrics

Return Value System

R Ratio

AMS_MKT_SEGMENT_
TYPE

CELL Target Segment Audience > 
Segment > Create

Type System

MARKET_
SEGMENT

Market Segment

AMS_OBJECT_USAGE_
TYPE

CREATED Created Campaign > 
Rollup or 
Execution 
Campaign > any 
campaign > 
Deliverable

 Usage System

USED_BY Used By

AMS_OFFER_LUMPSUM_
PAYMENT

ACCRUE Accrue Campaign > 
Rollup or 
Execution 
Campaign > any 
campaign > Offers > 
lump-sum offer

Payment Type

(in Lumpsum 
offers only)

Extensible

CHECK Issue Check

AMS_OFFER_STATUS ACTIVE Active Campaign > any 
campaign > Offer

Status System

CLOSED Closed

DRAFT Draft

PENDING Pending

REJECTED Rejected

AMS_OFFER_TYPE ACCRUAL Accruals Campaign > any 
campaign > Offer

Type System

LUMPSUM Lump Sum

OFF_INVOICE Off Invoice

OID Promotional Goods

ORDER Order value

Oracle Marketing Online Lookups 

Lookup Type Code Meaning Affected areas Field 
Access 
Level
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AMS_PRIORITY FAST_TRACK Fast Track Campaign > any 
campaign 

Priority Extensible

HIGH High

STANDARD Standard

LOW Low

MEDIUM Medium

VERY HIGH Very High

AMS_PRODUCT_LEVEL FAMILY Product Family Campaign > any 
campaign > 
Products 

Level System

PRODUCT Product

AMS_RESOURCE_STATUS BOOKED Booked Event > Execution 
Event > any event > 
Resources

 Status System

CONFIRMED Confirmed

AMS_TRIGGER_
FREQUENCY_TYPE

DAILY Daily Campaign > any 
campaign > Trigger 
> Setup

Frequency System

HOURLY Hourly

MONTHLY Monthly

NONE None

QUARTERLY Quarterly

WEEKLY Weekly

YEARLY Yearly

AMS_TRIGGER_TYPE DATE Date Campaign > any 
campaign > Trigger

Comparison 
Type

System

METRIC_
METRIC

Metric to Metric

METRIC_VALUE Metric to Value

METRIC_
WORKBOOK

Metric to Workbook

AMS_VENUE_TYPE CONVENTION_
CENTER

Convention Center Admin > General > 
Venue

 Venue Type User

HOTEL Hotel

KIOSK_BOOTH Kiosk/Booth

OZF_FUND_REQUEST_
STATUS

APPROVED Approved Campaign > any 
campaign > Budget

 Status System

PENDING Pending Approval

REJECTED Rejected

Oracle Marketing Online Lookups 

Lookup Type Code Meaning Affected areas Field 
Access 
Level
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Setting Up Status Classifications
Use this procedure to set up the status classifications used to categorize objects 
ranging from deliverables to speakers. The statuses you set up appear in the Status 
drop-down lists in each object. 

You can use this procedure to set up status designations for the following objects:

� List import

� Campaign schedules

� Campaigns

� Deliverables

� Marketing event agendas

� Marketing event registration

OZF_FUND_STATUS ACTIVE Active Budget> Budgets > 
Create

 Status System

CLOSED Closed

DRAFT Draft

PENDING Pending Approval

OZF_FUND_TYPE FIXED Fixed Budget> Budgets > 
Create

Type System

FULLY 
ACCRUED

Fully Accrued

STATISTICAL Statistical

OZF_PAYMENT_METHOD ADJUSTMENT Adjustment N-tier marketing 
use only. Affects 
budgets and 
claims.

System

CHECK Check

CREDIT_MEMO Credit Memo

DEBIT_MEMO Debit Memo

REJECT Reject

WRITE_OFF Write Off

OZF_UTILIZATION_TYPE ACCRUAL Accrual N-tier marketing 
use only. Affects 
budgets and 
claims.

Utilization 
Type

System

ADJUSTMENT Adjustment

UTILIZED Utilized

Oracle Marketing Online Lookups 

Lookup Type Code Meaning Affected areas Field 
Access 
Level
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� Marketing event speakers

� Marketing events

For example, you may want to classify deliverables as draft or approved, and 
speakers as contacted, confirmed, or cancelled.

Steps
1. Navigate to Admin > General >User Status.

2. From the Activity drop-down list, select the type of classification you wish to 
set up.

3. Use the System Status drop-down list select the status you want to map the 
classification to.

4. In User Status, enter the status.

5. If you wish to make this classification available only for a limited period of 
time, then enter a range of dates in the Start Date and End Date fields.

6. Click Update.

Creating and Editing Categories and Subcategories
Use this procedure to create both the Category and Subcategory drop-down lists 
used to classify campaigns, deliverables, events, budgets, metrics, and costs. The 
only difference between creating a category and a subcategory is that you specify a 
parent for a subcategory.

Prerequisites
If you are creating a subcategory, then you must create the parent category first.

Steps
1. Navigate to Admin > General >Category.

2. If you wish to create a new category or subcategory, then click Create. The 
Create Category subtab appears.

3. If you wish to edit a previous entry, then select the existing category or 
subcategory. The Category Details subtab appears.

4. Enter the name of the new category or subcategory. This name will appear in 
the Category or Subcategory drop-down list.
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5. From the Created For drop-down list, select the object for which you are 
creating this category or subcategory. 

6. If you are creating a subcategory, then, in Parent Category, click Go and use the 
list of values to enter the parent category.

7. Leave Liability Account and Adjustment Account blank. These are used by 
N-tier marketing implementations only.

8. Enter an optional description.

9. Make sure the Enabled check box is selected. Deselecting removes this category 
or subcategory from use.

10. Click Update.

Enabling the Budget Tab
Use this procedure to enable the budget tab.

Prerequisites
None

Steps
1.  Log on to Oracle Applications under the Application Developer responsibility.

2. Navigate to Applications > Menu.

3. From the View menu, choose Find.

4. Find "Oracle Marketing Root Menu".

5. In the Navigator Prompt column, locate Budget.

6. In the Budget record, use the list of values to make the following entries:

a. For Submenu, enter OZF_BUDGET_SUBMENU.

b. For Function, enter OZF_BUDGET_OVERVIEW. 

7. Save the record.

8. Bounce your Apache Server.

Setting Up the Campaign Tab
Use this procedure to set up the Campaign tab.
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Prerequisites
Log into Oracle Marketing Online. 

Steps
1. Set up the marketing mediums used to execute campaign activities. Please note 

that when a marketing medium is associated with an activity, it cannot be 
associated with another activity in the same time period. (Required)

2. Set up activities.(Required)

3. Create custom setups that will be used in campaigns and events. (Required)

Setting Up Geographical Regions
Use this procedure to set up geographical regions that are used to target campaigns. 

Prerequisites
None

Steps
1. If you wish to change the names of geographical levels the user sees in the 

Level drop-down list, then: 

a. Navigate to Admin > Geography > Location Type.

b. For each level, you can modify the existing Location Name. The user sees 
the Location Name in the Campaign Geography attribute list of values 
(LOV). You cannot add any additional locations or modify the preset levels. 

c. Enter an optional description.

d. Click Update.

2. Navigate to Admin > Geography > Geographic Area.

3. Enter the geographical hierarchy for your campaigns:

a. Click Create. 

The Geographic Areas dialog appears.

b. Use the Parent list of values (LOV) to enter a parent region for the child 
region you are creating. For example, if your company is targeting 
campaigns by different counties, then you will enter a specific state as a 
parent.
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The Type field is filled in automatically.

c. In the Child region, use the Type drop-down list to enter the type of area 
you are creating. In our example, county.

d. Enter a name and optional short name for the area.

e. Enter a start date. 

f. If you wish for this geographical area to expire, then enter an end date.

g. Click Update.

Mapping Your Customer Model on to Oracle Marketing Online
You can map your existing customer model to Oracle Marketing Online. Contact 
Oracle Consulting for further information.

Setting Up Data Fields for Lists
Use this procedure to determine which AMS_LIST_ENTRIES and AMS_IMPORT_
SOURCELINES table columns are available for list generation. Both tables contain 
256 user definable columns. By default, all columns are available. Use caution if you 
choose to carry out this procedure. If you make some of the columns unavailable, 
then you cannot make them available for list generation later on.

Prerequisites
None

Steps
1. Navigate to Admin > List > Data Fields.

2. Use the View drop-down list to select a table.

3. Deselect the Active check box for any field you wish to disable.

4. Click Update.

Setting Up Deduplication Rules
Use this procedure to determine which field(s) (table columns) will be used for 
deduping. The software uses the logical AND for deduping. This means that if you 
use multiple fields for deduping in a rule, then all of the fields have to match. 
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Prerequisites
None

Steps
1. Navigate to Admin > List > Deduplication Rules

2. If you wish to create a new deduplication rule, then:

a. Enter the rule name in the empty text box in the Rule Name column.

b. Enter an optional description.

c. From the Type drop-down list, select what type of list this rule will apply 
to.

d. Click Update.

The new rule appears in the list.

3. Select the name of the rule you just created or you wish to edit.

The List Rule subtab appears.

4. If you wish to add a column that will be used for deduplication, then: 

a. Click Go in the Column Name field and use the list of values to enter the 
name of that column. 

b. In Data Length, enter the number of characters to be matched. For example, 
if you specify 5 on a last name, then any two last names with the first five 
matching characters will be considered duplicates.

c. Click Update.

5. If you wish to remove a field from the rule, then: 

a. Select the Remove check box next to the rule you wish to remove.

b. Click Update.

Setting Up Word Replacement Rules
The Word replacement rules you enter using this procedure tell the application 
what words may be potential duplicates of each other. For example, a customer 
with the name of Robert Smith may be the same customer with the name of Bill 
Smith. Use this procedure to set up potential duplicate words for specific tables and 
columns.
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Steps
1. Navigate to Admin > List > Word Replacement

The Create Word Replacement subtab appears.

2. In the Original Word field, enter the target word, for example, Robert.

3. In the Replacement Word field, enter the duplicate word, for example, Bob.

4. Click Update.

5. Click the Details link for the word you just entered.

The List Word Replace Fields region appears.

6. Use the Field Table Name drop-down list to select the table for which you wish 
to use for this entry.

7. Use the Field Column Name list of values to enter the name of the column you 
wish to use.

8. Click Update.

9. If you wish to apply this entry to multiple columns, make additional entries in 
the Field Table Name and Field Column Name fields.

Setting Oracle Marketing Online System Profile Options
You can set the following system profile options:

Oracle Marketing Online System Profile Options

PROFILE NAME PROFILE DESCRIPTION

AMS_AUTO_REGISTER_FLAG If set to Yes, the profile automatically registers an 
individual on a wait list for an event when an enrollee 
cancels.         

Can be set at: Site, Application                                                                             

AMS_CALL_CENTER_
ENABLED

Setting this system profile option to Yes enables the 
transfer of data into Oracle Call Center. 

Can be set at: Site, Application                                         

AMS_CAMPAIGN_DISPLAY_
VERSION

AMS: Campaign Display Version

Can be set at: Site

AMS_CAMPAIGN_DEFAULT_
CALENDER

AMS: Marketing Calendar

Can be set at: Site
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AMS_CONF_CODE_PREFIX This prefix is added to the generated confirmation code 
for event registrations. The code can be alphanumeric, 
for example, a company name.      

Can be set at: Site, Application                                                                         

AMS_COPY_EVH_TO_EVO Enables copying Rollup Event information to its 
Execution Events.

Can be set at: Site                                                                                                

AMS_CURR_CONVERSION_
TYPE

This profile is used to specify the Oracle General Ledger 
conversion type that is used for Oracle Marketing Online 
transactions. For example, the currency conversion rate 
can be determined by a corporate conversion rate or a 
daily spot rate. 

Can be set at: Site, Application             

AMS_DEFAULT_CURR_CODE Determines the currency used for price list creation.          

Can be set at: Site                                                                

AMS:DEFAULT_TASK_RULE AMS: Default Task Rule

Can be set at: Application, Site             

AMS:DEFAULT_TIMEOUT AMS: Default Time Out Use For

Can be set at: Site             

AMS_HZ_DEDUPE_RULE Specifies which rule is used to control unwanted 
duplicates when customers are saved in the customer 
master table 
HZ_PARTIES.

Can be set at: Site, Application                                                                          

AMS_IMP_CTL_PATH Specifies the path to the SQL*Loader control file used for 
importing data. You must set this profile to run the 
AMSIPROC concurrent program.

Can be set at: Site

AMS_IMP_DATA_PATH Specifies the path for the data file to be imported. You 
must set this profile to run the AMSIPROC concurrent 
program.

Default = /amsdev/ams/11.5/bin/ 

Can be set at: Site

Oracle Marketing Online System Profile Options

PROFILE NAME PROFILE DESCRIPTION
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AMS_IMP_DEDUPE_RULES Specifies the rule the application follows to search for 
duplicates in the imported file itself. You must set this 
profile to run the AMSIPROC concurrent program.

Can be set at: Site, Application                                                                         

AMS_INV_API_CALLOUT AMS: Should Call to Inventory

Can be set at: Site

AMS_ITEM_ORGANIZATION_
ID

Determines the inventory organization (Master 
Organization) for the inventory items created for 
collateral and events in Oracle Marketing Online.

Can be set at: Site, Application                                                                            

AMS_LOWEST_
NOTIFICATION_LEVEL

AMS: Lowest importance level f

Can be set at: Site

AMS_NEWS_PER_COMPANY Determines the number of news items to be displayed 
for each company listed on a user’s home page. Users set 
this profile using the Preferences tab in the application.

Can be set at: Site, Application               

AMS_NUM_BIN_ITEMS Determines the number of items to be displayed in each 
of the bins on the home page. Users can set this profile 
using the Preferences tab in the application.

Can be set at: Site, Application                  

AMS_PRICELIST_HEADER_
NAME

All Events pricing will align under this price list header.

Can be set at: Site          

AMS_QP_PRICING_CALLOUT AMS: Should Call to Pricing Mo

Can be set at: Site      

AMS_SRCGEN_DATE_
PATTERN

AMS: Source Code Date Format

Can be set at: Site

AMS_SRCGEN_SEQUENCE_
LENGTH

AMS: Source Code Sequence Length

Can be set at: Site

AMS_SRCGEN_USER_CITY AMS: User country.

Oracle Marketing Online System Profile Options

PROFILE NAME PROFILE DESCRIPTION
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Implementing Oracle Web Discoverer
Use this procedure to install and implement Oracle Web Discoverer.

AMS_STOCK_SYMBOLS Determines which stock information displays on the 
home page. Enter the desired stock symbols. Users can 
set up this list using the Preferences tab in the 
application.

Can be set at: Site, Application                                           

AMS_SYSTEM_TIMEZONE_ID Enter the time zone for the system that runs system the 
Concurrent Manager. This profile option is required only 
for organizations working across multiple time zones.

Can be set at: Site              

AMS_TIME_FORMAT Controls the format in which time is displayed in Oracle 
Marketing Online.

Can be set at: Site, Application                         

AMS_USER_DEFAULT_TEAM AMS: Default Team for User

Can be set at: Site, Application, Responsibility, User         

AMS_USER_TIMEZONE_ID User’s time zone. This profile option is required only for 
organizations working across multiple time zones.

Can be set at: Site, Application                        

AMV_PROFILE_DEFAULT_
TICKER

Can be set at: Site

AMV_PROFILES_NEWS_ITEMS Can be set at: Site, User

OZF_AP_SOURCE OZF: AP Source for N-Tier Marketing

Can be set at: Site

OZF_ARCM_BATCH_SOURCE OZF: Credit Memo Batch Source for N-Tier Marketing

Can be set at: Site

OZF_ARDM_BATCH_SOURCE OZF: Debit Memo Batch Source for N-Tier Marketing

Can be set at: Site

Oracle Marketing Online System Profile Options

PROFILE NAME PROFILE DESCRIPTION
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Prerequisites
None

Steps
1. Install Oracle Web Discoverer from your CD. This includes the product and the 

patch. Make sure that you use the Oracle installer Discoverer provides. Use 
default Oracle Home while installing.

2. Verify your work:

a. Set up TNSNAMES by using oracle 8i Net8 easy configuration from your 
Start > Programs >Oracle Windows NT.

b. Launch Discoverer Admin Edition by selecting Start > Programs > Oracle 
Discoverer 3.1> Administration Edition. 

3. Install the Web Discoverer Server from your Discoverer 3i CD. Follow the 
installation guide Discoverer 3i Installation & Administration Guide Release 3.3 for 
the Web (A66104-02).

4. Make sure your Web server and browser are both supported by Oracle.

Oracle supported HTTP servers are:

� Oracle Application Server 

� Netscape Enterprise Server 

� Apache Server 

� MS Internet Information Server

Oracle Web Discoverer supported web browsers are:

� IE 3.x with JInitiator 

� IE 4.01 (4.72.3110.8 in the About box) and higher. 

� IE 5.0

� Netscape 3.0, 4.0X with Jinitiator 1.1.7

5. Make sure that the Locator (where your http server runs), Session, and 
Preferences components (where Oracle Web Discoverer server runs) must all be 
installed on the same subnet. You can ping them to get their IP address.

6. Make sure that the applet and HTML are accessible to the web server. Set up 
aliases in your web server configuration file if necessary. Test it by launching 
Oracle Web Discoverer welcome page provided in the documentation. If you 
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cannot launch the welcome page, your Oracle Web Discoverer installation has 
problems. Go back to your documentation and make sure you have followed 
the steps.

7. Make sure that the following parameters have been set up correctly in your 
preferences file (pref.txt) and apply the file:

� Machine Ips = "web server machine IP address or name"

� ShowUserTypeChoice 1

� DefaultUserTypeIsApps 1

� AppsGWYUID “APPLSYSPUB/PUB”

� AppsFNDNUM “APPS”

8. Create the End User Layer (EUL) and import EUL Export File (EEX) and 
Workbooks according to the steps outlined in the BIS11i Implementation Guide 
(A77481-02).

9. Verify your work:

a. Launch your Discoverer Admin edition

b. Open the business area Market Online.

c. Open up Market Online to see its folders.

d. Make sure you grant the right privileges and responsibilities to your 
business area.

e. Make sure that you use the right EEX for importing. Oracle Marketing 
Online business area is in biseul.eex.

f. Do not forget to refresh the business areas, the last step in the guide.

g. When creating the EUL, you must run a list of database GRANTs required 
by the EUL owner according to the documentation. Please make sure the 
following grants are run:

* grant select on FND_APPLICATION to eul_us; 

* grant select on FND_RESPONSIBILITY_VL to eul_us; 

* grant select on FND_ORACLE_USERID to eul_us; 

* grant select on FND_DATA_GROUP_UNITS to eul_us; 

* grant select on FND_USER_RESP_GROUPS to eul_us; 

* grant select on FND_USER to eul_us; 
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* grant select on FND_PRODUCT_INSTALLATIONS to eul_us; 

* grant execute on FND_CLIENT_INFO to eul_us; 

* grant select on FND_SECURITY_GROUPS_VL to eul_us;

The last two grants (highlighted in bold) are missing from the 
documentation. You must run these two grants or you will not be able to 
see Marketing Online Business Area folders.

10. Make sure that your tnsname is set up with the correct service name. (You will 
receive an “could not find service name” error if this is not set correctly.) To set 
the tnsname: 

a. Run Oracle 8 easy configuration. 

b. To verify, run SqlPlus to see whether you can connect to the database. 

11. Create a directory. For example: C:\mydisco

12. Create a sub-directory named secure under it. For example: 
C:\mydisco\secure

13. In the secure directory, create a dbc file. A typical dbc file looks like:

TWO_TASK=<database name, ex: OMDB>
GWYUID=APPLSYSPUB/PUB
GUEST_USER_PWD=<An account on Oracle application, you can create one 
with none responsibilities, ex: guest/guest>
FNDNAM=apps 
APPS_Jdbc_DRIVER_TYPE=THIN
DB_HOST=<database host name, ex: ap030sun.us.oracle.com > 
DB_PORT=<database port, ex: 1521>

14. For internal, you can go to unix $FND_TOP/secure directory to find a dbc 
template. For dbc document, refer to Appendix part in the Oracle Applications 
System Administrator’s Guide (A75396-02). Without setting this correctly, you will 
receive a “no dbc file found” error later on.

15. After creating dbc file, set up FND_TOP environment to where your dbc file sits 
(For example: C:\mydisco). 

a. If you are running on Microsoft NT, then set this environment in Start > 
Settings > Control Panel > System. Make sure that you set up a system 
variable instead of a user variable. Reboot.

b. If you are using the Unix operating system, then set up using the setenv 
command. 
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16. Make sure that the following ARU # 311532, 313216 have been applied to your 
system. The latest OMO ARU (1383055) has these ARUs in it. 

17. Make sure the Form Function AMS_LAUNCH_DISCO is created in the Oracle 
applications instance that will use Discoverer. To check:

a. Log on as PHP. For example: VISION\VISION98 on DOM1151.

b. Choose the APPLICATION DEVELOPER responsibility, choose 
Application > Function

c. Query Function Name AMS_LAUNCH_DISCO for details.

d. If Form Function AMS_LAUNCH_DISCO is not set up, you can set it up by 
following instructions described in the following URL: 
http://www-apps.us.oracle.com/bis/development/discoverer/index.htm

Use the navigation tree at left to navigate to Configuration > SSWA 
Integration > Form Function

18. Set the following ICX profiles in Oracle Applications:
 

19. The Oracle Applications APPS_WEB_AGENT profile must be setup and valid. 
Go to Oracle Application to verify.

20. Make sure that The EUL_TRIGGER$POST_SAVE_DOCUMENT function be 
registered and valid. This will ensure that work book SQL will be saved to the 
AMS_DISCOVERER_SQL table:

a. Navigate to Discoverer Admin edition.

b. Select Tools > Register PL/SQL functions. 

ICX _PROFILE: ICX_DISCOVERER_LAUNCHER 

Description:       URL that points to the Web Discoverer Server

Example:           http://ap152wgs.us.oracle.com/webdis/html/engli
sh/welcome.htm?Connect=[APPS_SECURE]

ICX_PROFILE: ICX_DEFAULT_EUL

Description:        This in combination with the language code make up the EUL 
owner at run time.

Example:              EUL (not EUL_US)
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c. Register this function according as follows, either by using the import 
buttons or by manually typing them in. Make sure you enter these 
parameters in order:

Name: EUL_TRIGGER$POST_SAVE_DOCUMENT
Display Name: eul_trigger$post_save_document  (lower case)
Owner: APPS
Package: AMS_DISCOVERERSQL_PVT
Database Link: <Default Database>
Return Type: Number
Check “Available in User Edition” check box

For the Arguments tab

P_WORKBOOKOWNER
P_WORKBOOKNAME
P_WORKSHEETNAME
P_SEQUENCE
P_SQLSEGMENT

All data types are varchar except for P_SEQUENCE which has a data type 
of Number. 

d. All of the arguments are required, so select the Required check box. 

e. Click Validate to validate the function you just registered. 

f. Exit Discoverer Admin Edition and User Edition (if you have them 
running) to make sure the changes are committed.

21. Create Workbooks:

a. Launch Discoverer in one of two ways:

� Using Discoverer User Edition (client/server version)

� By clicking the hyperlink in the Oracle Marketing Online GUI

b. After you launch Oracle Web Discoverer, select Creating Workbooks and 
pick the Oracle Marketing Online Business area. 

You will see a list of folders in this business area. Select the folder of your 
choice, click + to expand it. 

c. Each folder has one mandatory identifier item and one “Include XXX 
details” item (usually these are the first two items in your tree). You must 
select these two items for your workbook. You can but need not select the 
rest of the items.
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d. Use the wizard to specify your conditions. You can see your selections by 
executing the workbook.

22. Save the Workbooks into the database (not your computer). This create the SQL 
statement of your newly created workbook and store that into a database table.

23. If you do not see a list of workbooks from Oracle Marketing Online workbook 
LOV window and you do see a list of workbooks stored in your database, then 
your registered function is not setup correctly. You can check the function using 
Oracle Web Discoverer Administration Edition or you can also log in with 
SqlPlus to check whether there are any rows in the AMS_DISCOVERER_SQL 
table.

24. If you wish to share your Workbook with other users, then:

a. In Oracle Web Discoverer, choose File > Manage Workbooks > Sharing.

b. In Workbook > User tab, select the workbook you want to share.

c. Select the users you want to share the workbook and add these users to the 
shared area. 

d. Click OK.

Setting Up News and Stocks for the Home Tab
Use this procedure to set up the stocks and news feeds for users’ home tabs.

Prerequisites
The table AMV_STOCKS must contain data.

You must obtain a license from OneSource. Navigate to www.onesource.com for 
more information.

Steps
1. Run the KeyDaemon. Allow for 3-10 hours depending on how many stock key 

IDs you would like it to retrieve.

If you do not plan on updating the AMV_STOCKS table regularly, you don't 
need to leave the KeyDaemon running after the initial 3-10 hours. Its only 
purpose is to fetch key ids for companies whose stock symbols are in AMV_
STOCKS, but do not have key ids assigned to them yet. This will only occur 
after the initial run if you are updating the AMV_STOCKS table.
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2. Run the NewsDaemon. There are two kinds of updates that the NewsDaemon 
can perform: 

� A User Update: This update only fetches news for companies that are 
specified in specific user’s profiles. This kind of update can be performed at 
a minimum of once per hour. 

� A Global Update: This update fetch news for all the companies that have 
key ids in the database. This kind of update can be performed at a 
minimum of once per week. These limitations are set due to server-load 
restrictions on the content provider’s side. The update-interval for either 
type of update may be increased without limit. The NewsDaemon may be 
started with either type of update.

If a user adds a company to their profile, the news for that company will only 
show up immediately if three conditions are met: 

� The company symbol exists in AMV_STOCKS 

� The KeyDaemon has already retrieved the content-provider key for that 
company 

� Another user already had that company in their profile before the last user 
update or a global update has been done at least once.

Java Class Usage for KeyDaemon and NewsDaemon
Following is a list of the arguments and their meanings for the KeyDaemon and the 
NewsDaemon

KeyDaemon

Purpose: Specify the database host, port, alias, and log-in information.

Syntax:  -d <db connect string> <user or schema> <password>

Example(s):  -d jdbc:oracle:thin:@ap012sun:1521:reldev1 apps apps

Required: Yes

Default N/A

Purpose:  Specify the content provider code.

Syntax:  -v <vendor code 1>[, vendor code 2,...]
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Example(s):  -v ONE_SOURCE,HOOVERS, -v ONE_SOURCE (*currently 
only this vendor code is available)

Required: Yes

Default: N/A

Purpose Specify the interval to sleep between updates in hours minutes, seconds 
and milliseconds.

Syntax:    -u <HH:MM:SS:mm>

Example(s):  -u 01:00:00:00 (once every hour)

Required: No

Default:  24:00:00:00 (once every day)

Purpose: Specify a file to log errors to.

Syntax:  -f <logfile path>

Example(s):  -f /home/rjainend/keyd.log

Required: No

Default:  None

Purpose: Specify a network proxy host and port.

Syntax:  -p <proxy hostname> <proxy port>

Example(s):  -p www-proxy.us.oracle.com 80

Required:  Required only for organizations behind a fire wall.

Default:  None

Purpose: View the usage text.

Syntax: -h

Purpose: Write messages to standard output.
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Sample Usage
java oracle.apps.amv.news.KeyDaemon -d 
jdbc:oracle:thin:@ap012sun:1521:reldev1 apps apps -v ONE_
SOURCE -u 4:00:00:00 -f keyd.log -p www-proxy.us.oracle.com 80 
-verbose

Daemon News Usage

Syntax: -verbose

Purpose: Write debugging info to standard output.

Syntax: -debug

Purpose:  Specify the database host, port, alias, and log-in information.

Syntax: -d <db connect string> <user or schema> 
<password>

Example:  -d jdbc:oracle:thin:@ap012sun:1521:reldev1 apps 
apps

Required? Yes

Default:  N/A

Purpose:  Specify the content provider code.

Syntax: -v <vendor code 1>[, vendor code 2,...]

Examples: -v ONE_SOURCE,HOOVERS -v ONE_SOURCE (*currently only 
this vendor code is available)

Required?  Yes

Default:  N/A

Purpose:  Specify the interval to sleep between User Updates in hours, 
minutes,        seconds and milliseconds.

Syntax:  -su <HH:MM:SS:mm>
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Example: -su 1:00:00:00 (once every hour)

Required?  No

Default:  1:00:00:00 (once every hour)

Purpose:  Specify the interval to sleep between Global Updates in hours, 
minutes, seconds and milliseconds.

Syntax:  -lu <HH:MM:SS:mm>

Example:  -lu 168:00:00:00 (once every week)

Required? No

Default:  168:00:00:00 (once every week)

Purpose:  Specify the number of news items to fetch for each company 
during a User Update.

Syntax:  -sn <number of news items>

Example:  -sn 20

Required? No

Default:  20 (This is also the maximum number of news items allowed for 
a User Update)

Purpose:  Specify the number of news items to fetch for each company 
during a Global Update.

Syntax:  -ln <number of news items>

Example:  -ln 10

Required?  No

Default:  10 (This is also the maximum number of news items allowed for 
a Global Update)

Purpose:  Specify a file to log errors to.

Syntax:  -f <logfile path>

Example:  -f /home/rjainend/newsd.log
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Sample Usage
java oracle.apps.amv.news.NewsDaemon -d 
jdbc:oracle:thin:@ap012sun:1521:reldev1 apps apps -v ONE_
SOURCE -su 4:00:00:00 -sn 5 -lu 200:00:00:00 -ln 5 -f keyd.log 
-p www-proxy.us.oracle.com 80 -verbose -short

Required?  No

Default:  None

Purpose:  Specify a network proxy host and port.

Syntax:  -p <proxy hostname> <proxy port>

Example:  -p www-proxy.us.oracle.com 80

Required? No. Only necessary for an organization behind a fire wall.

Default:  None

Purpose:  Start the NewsDaemon in User Update mode. If this argument 
is not specified, the NewsDaemon starts in Global Update mode.

Syntax: -short

Purpose:  View the usage text.

Syntax: -h

Purpose:  Write messages to standard output.

Syntax:  -verbose

Purpose: Write debugging info to standard output.

Syntax: -debug
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Known Problems with Oracle Web Discoverer
� Current release does not work if cookies are disabled.

� If you do a refresh of the database, then the applications user password must be 
reset before users can log into Oracle Web Discoverer again.

� Errors with text such as: "Failed to connect to database - Unable to connect to 
Oracle Applications database (asfcpgcs)"

This occurs when you click on the Oracle Web Discoverer icon, bring up the 
Discoverer applet, but it fails to connect to the applications database. 

Cause: Discoverer dbc file in the secure directory is not set up correctly. or the 
TNSNAME is not set up right in Discoverer server.

� Errors such as "Wide Area Network Connection failed." often mean that you 
need to bounce the server. 

� If you have accessed another version of Oracle Web Discoverer before, then 
your browser cache may have the latest version of Discoverer objects. If you 
access a lower version of Oracle Web Discoverer, then you will get the wide area 
network connection error in Internet Explorer. 

For example:

“Unable to connect to the Oracle Discoverer Application Server:   -Wide 
area network connection failed. Locator interface incorrect.    Expecting 
version 3.3.3 got version 3.3.2.”

To resolve this in Internet Explorer:

1. Navigate to Tools > Internet Options > Settings >View Objects. 

2. Delete the Oracle Discoverer 3i and Oracle Discoverer 3i Initializer entries.

3. Exit all Internet Explorer browser windows and reconnect to the Oracle 
Marketing Online site.

Seeded Workflows

Application System Workflow File Name

AMS Continuous Campaign amsccamp.wft

Marketing Approvals amsvappr.wft

OZF Fund Request Approvals ozfvwreq.wft
166 Oracle Marketing Online Concepts and Procedures



Setting Up Marketing Mediums for Campaigns
Administering Oracle Marketing Online

Enabling Campaign and Event Approval Workflow
Use this procedure to enable the Workflow approval process for campaign themes 
and budgets. You must enable the Workflow for each campaign and event setup 
separately.

Prerequisites
You must create campaign setups first. 

Steps
1. Navigate to Admin > General > Custom Setup.

2. Click on the name of the setup you wish to enable.

The Custom Setup subtab appears.

3. If you wish to enable campaign theme approval using the default Oracle 
Marketing Online Workflow, then select the Show check box for Theme 
Approval. This is one of the last items on the list.

4. If you wish to enable campaign budget approval using the default Oracle 
Marketing Online Workflow, then select the Show check box for Budget 
Approval. This is one of the last items on the list.

5. Click Update.

Setting Up Marketing Mediums for Campaigns
Use this procedure to create or edit marketing mediums you use to execute the 
marketing activities for your company. A marketing medium can be a magazine or 
a television station you advertise in, an email server that sends out email 
promotions, or a telemarketing center. A marketing medium can have only one 
marketing activity associated with it at one time.

Prerequisites
Optional entry in Preferred Vendor, Party, and Managed By fields requires setup in 
Oracle financial applications.
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Steps
1. Navigate to Admin > General > Marketing Medium.

2. If you are creating a new entry, then click Create. Otherwise select the name of 
the marketing medium you wish to edit.

The Create Marketing Medium or Marketing Medium Detail subtab appears.

3. Enter or edit the name for the marketing medium.

4. Optionally, enter the other fields. The list of values for Preferred Vendor, Party, 
and Managed by come from ERP setups.

5. If you have not yet set up activities, then leave the Activity field blank. You can 
associate marketing mediums to activities while creating activities.

6. Click Create or Update.

You are now ready to set up activities.

Guidelines
The optional fields include:

Setting Up or Editing Activities for Campaigns and Events
Use this procedure to set up the activities for your campaigns and events. Each 
activity must be associated with one or more marketing mediums through which it 
is carried out. 

Field Name Description

Preferred Vendor Company name set up in Oracle Accounts Payable

Managed By Individual name set up in Oracle Human Resources

Party Party from the Oracle Customer Model

Active From and Active 
To 

Dates this marketing medium can be used

Internal, Outbound, and 
Inbound check boxes

Specifies which type of campaigns the marketing medium can 
be used for 

Activity Lets you assign a marketing medium to an activity. If you have 
not yet created your activities, then leave this field blank. 
Instead, do the assignment while creating your activities. 

Description Free text description
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For example, if you are running print ads in two newspapers, the Wall Street 
Journal and the Washington Post, and broadcasting a spot on one television station, 
then you may want to create two separate activities, one named "Print Advertising" 
and another named "Television Advertising". You associate the Print Advertising 
activity with two marketing mediums: The Wall Street Journal and the Washington 
Post. You associate the Television Advertising activity with the television marketing 
medium.

Prerequisites
You must set up marketing mediums before you can complete this procedure.

Steps
1. Navigate to Admin > General > Activity

2. If you are creating a new activity, then click Create.

3. If you are editing an existing activity, then select the name of the activity you 
wish to edit.

The Create Activity or Activity Details subtab appears, depending on whether 
you are creating or editing the activity.

4. Enter or modify the name of the activity. This activity name appears in the 
Activity drop-down list in campaigns and events.

5. Use the Activity Type list of values (LOV) to select an activity type for this 
activity. The activity appears in the Activity list of values, when users select this 
activity type only.

6. Select the Active check box.

7. Enter a description.

8. In the Marketing Mediums region, enter one or more media that can be used for 
this activity:

a. Use the Name drop-down list to select the marketing medium.

b. In Active From and Active To fields enter the date range for this activity. 
The dates must fall between the effective dates for the marketing medium 
you have chosen. 

9. Click Create or Update.
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Guidelines
The optional fields include:

Creating Custom Setups for Campaigns and Events
Use this procedure to create custom setups that customize what information users 
must enter for campaigns and events. A custom setup specifies:

� Which check-list attributes appear during campaign and event creation

� Which of these must be filled in by users before they can make a campaign or 
an event active

� The order in which the attributes are listed in the check list

When users create campaigns and events, they select one of the custom setups you 
create using the Setup Type drop-down list. 

Prerequisites
Before you carry out this procedure, you must set up:

� Marketing mediums

� Activities

Steps
1. Navigate to Admin > General> Custom Setup.

2. Click Create.

The Create Custom Setup subtab appears.

3. In Setup Name, enter a name for this custom setup. This is the name that 
appears in the Setup Type drop-down list during campaign and event creation 
and above the list of check-list attributes.

Field Name Description

Active, Response check 
boxes

Lets you classify if an Activity is related to outbound or inbound 
marketing activities.

Description Free text.

Marketing Medium 
Name

List of values with the marketing mediums you have set up 
previously.
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4. From the Associated With drop-down list, select whether you want to use this 
template for execution campaigns, rollup campaigns, execution events, or 
rollup events.

5. Use the Activity Type drop-down list to select an activity where this custom 
setup will appear. 

6. If you wish to limit the use of this custom setup further, then select an activity 
for the activity type. If you do not select an activity type, then this custom setup 
can be used for all activities for the activity type.

7. In the Components region, select the Show check box for attributes you wish to 
appear on the check list for the campaign or event using this custom setup.

8. If you wish to make any of the attributes mandatory for a campaign, then select 
the Mandatory check box next to each attribute. If a user does not make an 
entry in a mandatory attribute of a campaign, then the campaign cannot be 
used.

9. If you wish to modify the order in which the attributes appear on the check list 
then modify the numbering in the Sequence field.

10. If you wish to enable campaign theme approval using the default Oracle 
Marketing Online Workflow, then select the Show check box for Theme 
Approval. 

11. If you wish to enable campaign budget approval using the default Oracle 
Marketing Online Workflow, then select the Show check box for Budget 
Approval. 

12. Click Create.

Note: Making a check-list attribute mandatory requires users to 
make an entry in the attribute but does not require them to fill in all 
the information requested. Any entry satisfies the requirement and 
marks the attribute with a check mark. 
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Guidelines
The optional fields include:

Creating Metrics
Use this procedure to set up all metrics. This includes cost metrics as well as those 
metrics used to track the performance of your campaigns, events, and deliverables.

Prerequisites
None

Steps
1. Navigate to Admin > General > Metrics.

2. If you wish to create a new metric, then click Create.

3. If you wish to edit an existing metric, then select the metric to edit from the list. 

The Metrics Definition subtab appears.

4. Enter the metric name.

5. Optionally, select the metric category and subcategory.

6. From the Used With drop-down list, select what object uses this metric.

7. Enter an optional description.

8. In the Calculation region, select the radio button that describes how this metric 
is getting its values:

Field Name Description

Active check box Deselecting this check box removes this template from use.

Source Code Suffix Enter a suffix for the source code that is generated automatically 
whenever an agent creates a campaign.

This source code becomes the primary reference to the campaign 
and is referred to by the Oracle Telesales and Oracle Order 
Capture applications. It can be used to track the effectiveness of 
a campaign through consumer activity. When a campaign is 
defined, a source code may be manually entered by the user, or 
generated by the system automatically.

Marketing Medium 
Name 

LOV of Marketing Mediums you have set up previously.
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� If users are entering values in this metric, then select the Enter Value 
Manually.

� If this metric is getting its values from another metric then select Accrue 
through summarization. Use this selection both for metrics that summarize 
other metrics at the same level in the campaign or event hierarchy and 
those that summarize values from levels down the campaign or event 
hierarchy.

� If the metric is to get its value using an external program, then select the 
Calculate using Program and enter the path in the text box provided.

� If you wish the metric to be calculated using another metric, select 
Calculate using Metric, click Go and use the list of values (LOV) to enter 
the metric.

9. In the Summarize to region, enter information about where the metric is 
passing its values. Select one of the three radio buttons:

� If the metric is not passing its value to another metric, then select None.

� If the metric is passing its value to a metric in a parent rollup campaign or 
parent rollup event, then select of the Parent, click Go, and use the list of 
values (LOV) to enter the metric. The destination metric must be of type 
Accrue through summarization.

� If this metric is sending its values to another metric at the same level in the 
campaign or event hierarchy, then select at same level, click Go, and use 
the LOV to enter the name of the metric to which you are passing data. 

10. Click Update.

Creating Venues 
Venues describe the physical location where an event is being held. Use this 
procedure to set up venues for your events.

Prerequisites
None

Steps
1. Navigate to Admin > General > Venue

2. Click Create.
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The Create Venue subtab appears.

3. Enter the venue name, venue type, and other appropriate information about the 
venue.

4. Select the Active check box.

5. Click Create.

Guidelines
Make sure to use a unique name to identify a venue. For example, the name Hyatt 
Regency covers hotels in many locations. Use Hyatt Regency San Francisco instead
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